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1. INTRODUCTION TO COMPUTER
PART-I
|. CHOOSE THE CORRECT ANSWER:
. First generation computers used
(@) Vacuum tubes (b) Transistors () Integrated circuits  (d) Microprocessors
. Name the volatile memory
(a) ROM (b) PROM (c) RAM (d) EPROM
. |dentify the output device
(a) Keyboard (b) Memory (c) Monitor (d) Mouse
. |dentify the input device
(a) Printer (b) Mouse (c) Plotter (d) Projector
5.0utput device is used for printing building plan, flex board, etc.
(@) Thermal printer (b) Plotter (c) Dot matrix (d) inkjet printer
. Which one of the following isused In ATM machines,
(a) Touch Screen (b) speaker (c) Monitor (d) Printer
. When a system restarts ,which type of booting is used.
(a) Warm booting (b) Cold booting  (c) Touchboot  (d) Real boot.
. Expand POST
(a) Post on self-Test (b) Power on Software Test
c) Power On Self-Test  (d) Power on Self Text
Which one of the following is the main memory?
(a) ROM (b) RAM (c) Flashdrive  (d) Hard disk
10.Which generation of computer used IC’s?
(@) First (b) Second (c) Third (d) Fourth
PART-II
VERY SHORT ANSWERS:
1. What isa Computer?
% A computer is an electronic device that processes the input according to the set of
instructions provided to it and gives the desired output at a very fast rate

2. Distinguish between Data and | nfor mation.

Data | nfor mation

Datais defined as an unprocessed Information is a collection of facts from
collection of raw facts, suitable for which conclusions may be drawn.
communication, interpretation or
processing.

Example: 134, 16, ‘Kavitha’, ‘C’ Example: Kavithais 16 years old.

3. What are the components of the CPU?

s Control Unit

% Arithmetic and Logic Unit (ALU) and

% Memory Unit

4. What isthe function of an ALU?
s The ALU isapart of the CPU where various computing functions are performed on data.
% The ALU performs arithmetic operations such as addition, subtraction, multiplication,

division and logical operations




% Thelogical operations of ALU promote the decision-making ability of acomputer.
5. Writethe functions of control unit.

» The control unit controls the flow of data between the CPU, memory and

|/O devices.

> It also controls the entire operation of a computer.

6. What isthe function of memory?

The Memory Unit is of two types are,

Primary Memory: The primary memory is used to temporarily store theprograms
and data when the instructions are ready to execute.
Secondary Memory: The secondary memory is used to store the data permanently.

. Differentiate I nput and Output unit.

| nput Unit

Output Unit

Input unit is used to feed any form
of data to the computer, which can
be stored in the memory unit for
further processing.

An Output Unit is any hardware
component that conveys information to
users in an understandable form.

Example: Keyboard, mouse, etc.

Example: Monitor, Printer etc.

Distinguish Primary and Secondary memory.

Primary Memory

Secondary Memory

The Primary Memory isvolatile, that is,
the content is lost when the power supply
is switched off.

The Secondary memory is non-volatile,
that is, the content is available even after
the power supply is switched off.

The Random Access Memory (RAM) is
example of a main memory.

Hard disk, CD-ROM and DVD ROM are
examples of secondary memory.

PART-III
SHORT ANSWERS:
What are the Char acteristics of Computer?
Speed
Accuracy
Consistency
Flexibility
Diligence
Storage Capacity
Write the applications of computer.
various applications of computers in today'sare:
Business
Education
Marketing
Banking
Insurance
Communication
Health Care
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v Military
v' Engineering Design
3. What isinput device? Give two examples.
Input device is used to feed any form of data to the computer, which can be stored in
the memory unit for further processing.
Example: Keyboard, mouse, Scanner, Fingerprint scanner, Track Ball, Retinal
Scanner, Light pen etc.
4. Name any three output devices.
Monitor, Printer, Plotter, Speaker, Multimedia Projectors are the output devices.
5. Differentiate optical and Laser M ouse.
Optical Mouse Laser Mouse
It uses light source to judge Laser Mouse uses Laser Light instead of a
the motion of the pointer. light source.
Optical mouse is less sensitive towards Laser Mouse is highly sensitive and able
surface. to work on any hard surface.
6. Write short note on impact printer.
% These printers print with striking of hammers or pins on ribbon.
% These printers can print on multi-part (using carbon papers) by using
mechanical pressure.
s Example: Dot Matrix printers and Line matrix printers are impact printers.
7. Writethe characteristics of sixth generation.
In the Sixth Generation, computers could be defined as the era of intelligent
computers, based on Artificial Neural Networks.
One of the most dramatic changes in the sixth generation will be the explosivegrowth
of Wide Area Networking.
Natural Language Processing (NLP) isacomponent of Artificial Intelligence (Al).
It provides the ability to develop the computer program to understand human
language.
8. Writethe significant features of Monitor.
+«*Monitor isthe most commonly used output device to display the information.
+* Pictures on a monitor are formed with picture elements called PIXELS.
% Monitors may either be Monochrome which display text or images in Black and White
or can be colour, which display results in multiple colours.
« There are many types of monitors available such as CRT (Cathode Ray Tube), LCD
(Liquid Crystal Display) and LED (Light Emitting Diodes).
The monitor works with the VGA (Video Graphics Array) card.
The video graphics card helps the keyboard to communicate with the screen.
It acts as an interface between the computer and display monitor.
Usually the recent motherboards incorporate.
PART-1V
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EXPLAIN IN DETAIL:
1. EXPLAIN THE BASIC COMPONENTSOF A COMPUTER
WITH A NEAT DIAGRAM.

[nput Unit:
Input unit is used to feed any form of datato the computer, Which can be stored in
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the memory unit for further processing.
Example: Keyboard, Mouse, etc.
Central Processing Unit:

e CPU isthe mgor component which interprets and executes software instructions. It
also controls the operation of all other components such as memory, input and output
units.

e |t accepts binary data as input process the data according to the instructionsand
provides the result as output.

e The CPU has three components which are Control unit, Arithmetic and logic unit
(ALU) and Memory unit.

Arithmetic and L ogic Unit:
The ALU isa part of the CPU where various computing functions are performed on
data.
The ALU performs arithmetic operations such as addition, subtraction, multiplication,
division and logical operations.
The result of an operation isstored in internal memory of CPU.
The logical operations of ALU promote the decision-making ability of acomputer.
Contral Unit:
e The control unit controls the flow of data between the CPU, memory and 1/O devices.
e |t aso controls the entire operation of a computer.
Qutput Unit:
An Output Unit is any hardware component that conveys information to usersin an
understandable form.
Example: Monitor, Printer etc.
Memory Unit:

e The Memory Unit is of two types which are primary memory and secondary memory.

e The primary memory is used to temporarily store the programs and data.

e The secondary memory is used to store the data permanently

e The Primary Memory is volatile; the Random Access Memory (RAM) is an example
of a main memory.

The Secondary memory is non-volatile.
Hard Disk, CDROM and VD ROM are examples of secondary memory.

| eeddir Sreem ]
Fig: Components of a Computer

Discuss the various gener ations of computers.
First generation -1940- 1956(VACCUM TUBES)
Second generation -1956-1964 (TRANSISTORYS)
Third generation -1964-1971 (INTEGRATED CIRCUIT)
Fourth generation -1971-1980 ( MICROPROCESSOR )
Fifth generation -1980 to till date (ULTRA LARGE SCALE INTEGRATION)
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Sixth generation - IN FUTURE.

Generation & Period

Main Component Used

MeritsDemerits

First Generation
(1940-1956)

V acuum tubes

Biginsize

Consumed more power
Malfunction due to
overheat

Machine Language was
used.

Second Generation
(1956-1964)

Transistors

Smaller compared to
First Generation.
Generated Less Heat.
Consumed less power
when compared to first
generation

Punched cards were
used.

First operating system
was developed — Batch
Processing and
Multiprogramming
Operating System.
Machine language as
well as Assembly
language was used.

Third Generation
(1964-1971)

Integrated
Circuits (IC)

Computers were
smaller, faster and more
reliable.

Consumed less power.
High Level Languages
were used.

Fourth Generation
(1971-1980)

Microprocessor
Very Large Scale
Integrated Circuits
(VLSI)

Smaller and Faster.
Microcomputer series
such asIBM and
APPLE were
developed.

Portable Computers
were introduced.

Fifth Generation
(1980 - till date)

Ultra Large Scale
Integration (ULSI)

Parallel processing
Super conductors
Computer size
was drastically
reduced

Can recognize
images and




graphics

Introduction of
artificial

intelligence and

expert system

Able to solve

high complex
problems

including

decision making

and logical

reasoning

Sixth Gener ation Parallel and Distributed
(In future) computing.

Computers have
become smarter,

faster and

smaller.

Development of robotics.
Natural Language
Processing.
Development of Voice
Recognition Software.

3. EXPLAIN THE FOLLOWING
a) Inkjet printer

b) Multimedia projector

c) Barcode/QR code reader

a) Inkjet printer:

Inkjet printers use color cartridges which combined magenta, yellow and cyan inks to
create color tones. A black cartridges is also used for monochrome output. Inkjet printerg
work by spraying ionized ink at a sheet of paper. The speed of inkjet printer range from
1-20 PPM ( Pages Per Minute).

They use the technology of firing ink by heating it so that it explodes towards the paper
in bubbles or by using piezoelectricity in which tiny electric currents controlled by
electronic circuits are used inside the printer to spread ink in jet speed. An inkjet printer
can spread millions of dots of ink at the paper every single second.

b) Multimedia projector:
Multimedia Projectors are used to produce computer output on a big screen. These
are used to display presentations in meeting halls or in classrooms.

c) Barcode/QR code reader

A Bar codeis apattern printed in lines of different thickness. The bar code reader
6




scans the information on the bar codes transmits to the computer for further processing. The
system gives fast and error free entry of information into the computer.

QR ( Quick Response) code: The QR code is the two dimension bar code which can be
read by a camera and processed to interpret the image.




2. NUMBER SYSTEM
PART-I
|. CHOOSE THE BEST ANSWER
1. Which refers to the number of bits processed by a computer’s CPU?
A) Byte B) Nibble C) Word length D) Bit
2. How many bytes does 1 Kilo Byte contain?
A) 1000 B) 8 C4 D) 1024
3. Expansion for ASCI|
A) American School Code for Information Interchange
B) American Standard Code for Infor mation I nterchange
C) All Standard Code for Information I nterchange
D) American Society Code for Information Interchange
4. 2"50 isreferred as
A) Kilo B) Tera C) Peta D) Zetta
5. How many characters can be handled in Binary Coded Decimal System?
A) 64 B) 255 C) 256 D) 128
6. For 1101, , the equivalent Hexadecimal equivalent is?
A) F B) E C)D D)B
7. What isthe 1’s complement of 001001107?
A) 00100110 B) 11011001 C) 11010001 D) 00101001
8. Which amongst this is not an Octal number?
A) 645 B) 234 C) 876 D) 123
PART - 11
VERY SHORT ANSWERS:
1. What isdata?
% The term data comes from the word datum, which means araw fact.
% The data isafact about people, places or some objects.
2. Write the 1’s complement procedure.
e Thisisfor negative numbersonly i.e. the number whose MSB is 1
Step 1: Convert given Decimal number into Binary
Step 2: Check if the binary number contains 8 bits, if less add O at the left most bit, to
make it as 8 hits.
Step 3: Invert al bits (i.e. ChangelasOandOas 1)
Example: Find 1’s complement for (-24)10

Ciiven Binary I's Compliment

Numbes Number

(«24) Q001 1001 11100111

3. Convert (46)10 into Binary number
46/2=23+0 , MSB
23/2=11+1
11/2=5+1
46)10=(10111
5/o=941 (46)10=(101110)
2/2=1+0

LSB




4. We cannot find 1’s complement for (28)10. State reason.
% (28)10 is positive number.
% 1’s Complement represents signed numbers (Negative numbers) only. So,
(28)10 cannot find 1’s complement.
5. List the encoding systems that represents charactersin memory.
BCD - Binary Coded Decimal
EBCDIC — Extended Binary Coded Decimal Interchange Code
ASCII — American Standard Code for Information I nterchange Unicode
ISCII — Indian Standard Code for Information Interchange
Unicode
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PART-III
SHORT ANSWERS:
. What isradix of a number system? Give example

A numbering system isaway of representing numbers. Each number system is
uniquely identified by its base value or radix. Radix or base is the count of number of
digits in each number system.

“ Radix or base isthe general idea behind positional numbering system.

2. Write note on binary number system.

Thereareonly TWO DIGITS inthe Binary system, namely, 0 and 1.

% The numbers in the binary system are represented to the base 2 and thepositional
multipliers are the powers of 2.

% The left most bit in the binary number is called as the M ost Significant Bit (M SB) and
it has the largest positional weight.

% Theright most bit isthe L east Significant Bit (LSB) and has the smallest positional
weight.

3. Convert (150)10 into Binary, then convert that Binary number to Octal.
150/2=75+0 msB
75/2=37+1%
37/2=18+1
18/2=9+0
9/2=4+1
4/2=2+0
2/2=1+0

(150)10=(10010110),

LSB

Ol Ol0 110
\ A A J
Y Y Y
. 2 O

I (10010110); = (220)4 ]

4. Writeshort noteon | SCI|I.
e |SClI isthe system of handling the character of Indian local languages.
e Thisas a8-hit coding system.




e Therefore it can handle 256 (28) characters.

e This system isformulated by the department of Electronicsin Indiain the year 1986-
88 and recognized by Bureau of Indian Standards (BIS).
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b) 2010+2510

EXPLAIN IN DETAIL:
1. a) Writethe procedureto convert fractional Decimal to Binary

The method of repeated multiplication by 2 has to be used to convert such
kind of decimal fractions.

The steps involved in the method of repeated multiplication by 2:
Step 1. Multiply the decimal fraction by 2 and note the integer part. The integer part is either
Oor 1.
Step 2: Discard the integer part of the previous product. Multiply the fractional part of the
previous product by 2. Repeat Step 1 until the same fraction repeats or terminates (0).
Step 3: The resulting integer part forms a sequence of 0s and 1s that become the binary
equivalent of decimal fraction.
Step 4: The final answer is to be written from first integer part obtained till the last integer
part obtained.

Integer part

(O O

)
, _c:i': 0
S

| . & I

Write the integer parts from top to bottom to obtain the equivalent fractional binary number.
Hence,
(0.2)10=(0.00110011...)2 = (0.00110011)>

10




b. Convert (98.46)10 to Binary
L. Integer part

2 Fractional parnt

1

(98.46)10 = (1100010.01110.....)

. Find 1’s Complement and 2’s Complement for the following Decimal number
a) -98

= 98,,= 1100010

S bit format of 98 01100010

]

1's complement = 10011101
Add 1| tat : +1
~ 10011110

s complement

b) -135

135,,= 10000111

1's complement : 01111000
Add 1 bat = +1
s complement = 01111001

3.a) Add 1101010,+101101> b) Subtract 1101011, - 111010
1101010 1101011

+ 101101 - 111010

110001




3.COMPUTER ORGANIZATION PART -

CHOOSE THE CORRECT ANSWER
1. Which of the following is said to be the brain of a computer?

(@) Input devices (b) Output devices (c) Memory device  (d) Microprocessor
2. Which of the following is not the part of a microprocessor unit?

(a) ALU (b) Control unit  (c) Cache memory (d) register
3. How many bits constitute a word?

(a) 8 (b) 16 (c) 32 (d) determined by the processor used.
4. Which of the following device identifies the location when address is placed in the
memory address register?

(a) Locator (b) encoder (c) decoder (d) multiplexer
5. Which of the following isa CISC processor?

(&) Intel P6 (b) AMD K6 (c) Pentium [11  (d) Pentium IV
6. Which isthe fastest memory?

(@) Hard disk (b) Main memory (c) Cache memory (d) Blue-Ray dist
7. How many memory locations are identified by a processor with 8 bits address bus at a
time?

(a) 28 (b) 1024  (c) 256 (d) 8000
8. What isthe capacity of 12cm diameter DV D with single sided and single layer?

(a) 4.7 GB (b) 5.5GB (c)7.8GB (d)2.2GB
9. What isthe smallest size of datarepresented ina CD?

(a) blocks (b) sectors (c) pits (d) tracks
10. Display devices are connected to the computer through.

(a) USB port (b) Ps/2 port (c) SCSI port (d) VGA connector

Part — 11
VERY SHORT ANSWERS
1. What arethe parameter s which influence the characteristics of a
micr opr ocessor ?
a) Clock speed
b) Instruction set
c) Word size
2. What isan instruction?
A command which is given to a computer to perform an operation on data is
called an instruction.
3. What isa program counter ?
The Program Counter (PC) is a special register in the CPU which always
keeps the address of the next instruction to be executed.
4. What isHDM17?

High-Definition Multimedia Interface is an audio/video which interface
transfers the uncompressed video and audio data from a video controller, to a compatible
computer monitor, LCD projector, digital television etc.

5. Which sourceisused to erase the content of a EPROM ?

EPROM retains its contents until it is exposed to ultraviolet light. The

ultraviolet light clears its contents, making it possible to reprogram the memory.

12
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PART-III
SHORTANSWERS:
Differentiate Computer Organization from Computer Architecture.
Computer organization deals with the hardware components of a computer system.
Computer architecture deals with the engineering considerations involved indesigning
a computer.

. Classify the microprocessor based on the size of the data.

8-bit microprocessor

16-bit microprocessor
32-bit microprocessor
64-bit microprocessor

. Write down the classifications of microprocessor s based on the instruction set.

RISC stands for Reduced Instruction Set Compuiters.
Complex Instruction Set Computers (CI SC)

. Differentiate PROM and EPROM.

PROM:

Programmable read only memory is also a non-volatile memory on which data can be
written only once.

PROM is manufactured as a blank memory

PROM programmer or a PROM burner is used to write datato a PROM chip.

The process of programming a PROM s called burning the PROM.

EPROM:

Erasable Programmable Read Only Memory is a special type of memory which serves
as a PROM,

The content can be erased using ultraviolet rays.

An EPROM differs froma PROM, PROM can be written only once and cannot be
erased.

EPROMSs are used widely in personal computers because they enable themanufacturer
to change the contents of the PROM to replace with updated versions or erase the
contents before the computer is delivered.

Write down theinterfaces and ports available in a computer.

Serial Port

Parallel Port

USB Ports

USB 3.0

VGA Connector

Audio Plugs

PS/2 Port

SCSI Port

High Definition Multimedia Interface (HDMI)




6. Differentiate CD and DVD

CD DVD
A CD or CD-ROM is made from % A DVD (Digital Versatile Disc
1.2 millimetres thick, or Digital Video Disc) isan
polycarbonate plastic material. A optical disc.
thin layer of aluminium or gold % DVDs are often used to store
Is applied to the surface. movies at a better quality. DVDs
CD dataisrepresented as tiny are read with a laser.
indentations known as "pits’, % The disc can have one or two
The areas between pits are sides, and one or two layers of data
known as "lands". per side;

¢ The capacity of an %+ Capable of storing up to 4.7

ordinary CDROM is GB of data.
700MB.

7. How will you differentiate a flash memory and an EEPROM ?
Flash memory devices:
Flash memory is an electronic (solid-state) non-volatile computer storage medium that
can be electrically erased and reprogrammed.

% Flash memories can be used in personal computers, Personal Digital Assistants(PDA),
digital audio players, digital cameras and mobile phones.
Flash memory offers fast access times.
The time taken to read or write a character in memory is called access time.
Examples for Flash memories are pen drives, memory cards etc.
EEPROM:

% Electrically Erasable Programmable Read Only Memory can be erased by exposing it
to an electrical charge.
EEPROM isnon-volétile.
EEPROM is slower in performance.

PART-1V
EXPLAIN IN DETAIL:
1. Explain the characteristics of a microprocessor .
A Microprocessor’s performance depends on the following characteristics:

Clock speed
Instruction set
Word size
a) Clock Speed:
Every microprocessor has an internal clock that regulates the speed at whichit
executes instructions.
The speed at which the microprocessor executes instructions is called the clock speed.
Clock speed is measured in MHz (Mega Hertz) or in GHz (Giga Hertz).
b) Instruction Set:
A command which is given to a computer to perform an operation on data is called as
an instruction.
Basic set of machine level instructions that a microprocessor is designed to execute is

14




called as an instruction set. Thisinstruction set carries out the following types of
operations:

Data transfer

Arithmetic operations

Logical operations
Control flow
I nput/output
c) Word Size:
% The number of bits that can be processed by a processor in a single instructionis
called its word size.
% Word size determines the amount of RAM that can be accessed by a microprocessor
2. How theread and write operations ar e performed by a processor ? Explain.
The Central Processing Unit (CPU) has a Memory Data Register (MDR) anda
Memory Address Register (MAR).
The Memory Data Register (MDR) keeps the data which istransferred betweenthe
Memory and the CPU.
The Program Counter (PC) is a special register in the CPU which always keeps the
address of the next instruction to be executed.
The Arithmetic and Logic unit of CPU places the address of the memory to befetched,
into the Memory Address Register (MAR).
A bus isa collection of wires used for communication between the internal
components of a computer.
The word inthe RAM has the same size (no. of bits) as the Memory Data Register
(MDR). If the processor is an 8-bit processor like Intel 8085, its MDR and the word in
the RAM both have 8 bits.
The read operation transfers the data (bits) from word to Memory Data Register. The
write operation transfers the data (bits) from Memory Data Register to word.
3. Arrangethe memory devicesin ascending order based on the accesstime.
A memory isjust like a human brain. It is used to store data and instructions.
Computer memory is the storage space in the computer, where data and instructions
are stored.
There are two types of accessing methods to access (read or write) the memory. They
are
. Sequential Access and
. Random Access
SEQUENTIAL ACCESS:
The memory is accessed in an orderly manner from starting to end.
RANDOM ACCESS:
Any byte of memory can be accessed directly without navigating through previous
bytes. Different memory devices are arranged according to the capacity, speed and cost.
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4. Explain the types of ROM.
Read only memory refers to special memory in a computer with pre-recorded data at
manufacturing time which cannot be modified.
The stored programs that start the computer and perform diagnostics are available in
ROMs.
ROM stores critical programs such as the program that boots the computer.
Once the data has been written onto a ROM chip, it cannot be modified or removed
and can only be read.
ROM retains its contents even when the computer is turned off.
ROM iscalled as a non-volatile memory.

PROM:
% Programmable read only memory is also a non-volatile memory on which data can be

o
o
o
EPR
o

/7
0‘0

/7
0‘0

written only once.

PROM is manufactured as a blank memory, whereas a ROM is programmed during
the manufacturing process itself.

PROM programmer or a PROM burner is used to write datato a PROM chip.

The process of programming a PROM s called burning the PROM.

Erasable Programmable Read Only Memory is a special type of memory which servesas
PROM, but the content can be erased using ultraviolet rays.

An EPROM differs from a PROM, PROM can be written only once and cannot be
erased.

EPROMSs are used widely in personal computers because they enable the manufacturer
to change the contents of the PROM to replace with updated versions or erase the
contents before the computer is delivered.

EEPROM:

R/
0.0

R/
0.0

R/
0.0

Electrically Erasable Programmable Read Only Memory can be erased by exposingit
to an electrical charge.

EEPROM isnon-volétile.

EEPROM is slower in performance.




4. THEORETICAL CONCEPTSOF OPERATING SYSTEM
PART-I
Choose the correct answer :
1. Operating systemisa
A) Application Software B) Hardware C) System Software D) Component
2. ldentify the usage of Operating Systems
A) Easy interaction between the human and computer
B) Controlling input & output Devices
C) Managing use of main memory
D) All the above
. Which of the following is not a function of an Operating System?
A) Process Management B) Memory Management
C) Security management D) Complier Environment
. Which of the following OS isa commercially licensed Operating system?
A) Windows B) UBUNTU C) FEDORA D) REDHAT
. 5) Which of the following Operating systems support Mobile Devices?
A) Windows 7 B) Linux C)BOSS D)iOS
. 6) File Management manages
A) Files B) Folders C) Directory systems D) All the Above
. 7) Interactive Operating System provides
A) Graphics User Interface (GUI) B) Data Distribution
C) Security Management D) Real Time Processing
. 8) An example for single task operating system
A) Linux  B) Windows C) MSDOS D) Unix

. 9) The File management system used by Linux is
A) ext2 B) NTFS C)FAT D) NFTS
PART-I|

VERY SHORT ANSWERS:
1. List any two uses of Operating system?

To ensure that a computer can be used to extract what the user wants it do.

Easy interaction between the users and computers.

Starting computer operation automatically when power isturned on (Booting).

Controlling Input and Output Devices

Manage the utilization of main memory.

Providing security to user programs.

What is multi-user Operating system?

It is used in computers and laptops that allow same data and applications to be

accessed by multiple users at the same time.

The users can also communicate with each other. Windows, Linux and UNIX are

examples for multi-user Operating System.

3. What isa GUI?

% The GUI isawindow based system with a pointing device to direct |/O, choose from
menus, and make selections and a keyboard to enter text.

% Itsvibrant colors attract the user very easily.

4. What arethe security management features available in Operating System?
(1) File access level
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(2) System level
(3) Network level

. What is multi-processing?

% OO
DX

%

*

%

*

%

*
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This is a one of the features of Operating System. Operating System has two or more
processors for a single running process (job). Processing takes place in parallel is
known as parallel processing.
Since the execution takes place in parallel, this feature is used for high speed execution
which increases the power of computing.
What ar e the different Operating Systems used in computer ?
Single User Operating Systems
Multi-user Operating Systems
Multi-Processing Operating Systems
Distributed Operating Systems
Prominent Operating Systems
PART-III

SHORT ANSWER

1.

What ar e the advantages and disadvantages of Time-sharing featur es?

Advantages Disadvantages

It allows execution of multiple tasks or Problem of Reliability

Processes concurrently

Quick Response Questions of security and integrity of uses

programs and data

Avoids duplication of software Problem of data communication

Reduces CPU idle time Various processes after atime is elapsed.
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List the key features of Operating system
User Interface
File Management
Memory Management
Process M anagement
Fault tolerance
Security Management
Write a note on M ulti processing
Operating System has two or more processors for a single running process (job).
Processing takes place in parallel isknown as parallel processing.
Since the execution takes place in parallel, this feature is used for high speed
execution which increases the power of computing.
PART-1V

EXPLAIN IN DETAIL:

1.

Explain the concept of a Distributed Operating System along with its advantages.

¢ The Distributed Operating System is used to access shared data and files that reside
in any machine around the world using internet/ intranet. The user can handle the
data from different locations.




% The users can access as if it isavailable on their own computer.
The advantages of distributed Operating System ar e as follows:
% A user at one location can make use of all the resources available at another location
over the network.
Many computer resources can be added easily in the network .
I mproves the interaction with the customers and clients.
Reduces the load on the host computer.
. List out the pointsto be noted while creating a User Interface for anoperating
system?
User interface is one of the significant features in Operating System. The only way
that user can make interaction with a computer.
The following points are considered when User Interface is designed for an
application.
The user interface should enable the user to retain this expertise for alonger time.
The user interface should also satisfy the customer based on their needs.
The user interface should save user’s precious time. The ultimate aim any product is
to satisfy the customer
The User Interface must satisfy the customer.
The user interface should reduce number of errors committed by the user
. Explain Process management technique in Operating system
Process management is function that includes creating and deleting processes
providing mechanisms for processes to communicate and synchronize with each other.
* The Operating System isresponsible for the following activities associated with
the pr ocess management:
Operating system processes which is executed by system code.
User processes which is executed by user code.
The following algorithms are mainly usedto allocate the job (process) to the
processor.
1. FIFO
2. SIF
3. Round Robin
4. Based on Priority
. FIFO (First In First Out) Scheduling:
This algorithm is based on queuing technique. The process that enters the queue first is
executed first by the CPU, followed by the next and so on.
The processes are executed in the order of the queue (row).
. SJF (Shortest Job First) Scheduling:
This algorithm works based on the size of the job being executed by the CPU.
Consider two jobs A and B.
A = 6 kilo bytes 2) B = 9 kilo bytes. First the job “A” will be assigned and then job
“B” gets its turn.
. Round Robin Scheduling
The Round Robin (RR) scheduling algorithm is designed for time sharing systems.
Jobs (processes) are assigned and processor time in a circular method.




Example Take threejobs A, B, C.

First thejob A isassigned to CPU then job B and job C and then again A, B and C
Based On Priority

The given job (process) is assigned based on a Priority.

The job which has higher priority is processed first.

Take two jobs A and B.

Let the priority of A be 5 and priority B be 7.

Job B isassigned to the processor before job A.

>
>
4.
>
>
>
>
>




5. WORKING WITH WINDOWS OPERATING SYSTEM
PART-I
CHOOSE THE BEST ANSWER:
1. From the options given below, choose the operations managed by the operating
system.
a. Memory b. Processor c. I/0O devices d. all of the above
2. Which isthe default folder for many Windows Applications to save your file?
a. My Document b. My Pictures c.Documents and Settings  d. My Computer
3. Under which of the following OS, the option Shift + Delete — permanently
deletes afile or folder?
a. Windows 7 b. Windows 8 c.Windows10 d. All of the OS
4. What isthe meaning of "Hibernate" in Windows XP/Windows 77?
a. Restart the Computer in safe mode
b. Restart the Computer in hibernate mode
c¢. Shutdown the Computer terminating all the running applications
d. Shutdown the Computer without closing the running applications
5. The shortcut key used to rename a file in windows
a.F2 b. F4 c. 5 d. F6
PART-B
VERY SHORT ANSWERS:
1. What isknown as Multi-Tasking?
% Multiple applications which can execute simultaneously in windows is known
as “Multi-Tasking”.
2. What are called standard icons?
% Theicons which are available on desktop by default while installing Windows OSare
called standard icons.
% The standard icons available in all Windows OS are My Computer, Documentsand
Recycle Bin.
3. Differentiate Files and Folders.

Files Folders

File is the collections of data/information. | Folder is a collection of files.
(Records).

CreateaFile Createafolder:
Start All programs— select application— | Right click new Folder ok
ok

. Differentiate Save and Save As option.

“Save” option save a new document in first time. (Ctrl+S)
“Save As” option save analready saved the document with a new name and also
create a copy of already saved document with a new name obviously.

5. How will you Rename a File?
To Rename afile,

1. Click File > Rename

2. Press F2 or click over the file or folder. A surrounding rectangle will appear around

the name. Type in the new name
3. Click the right mouse button over the file or folder. Select Rename from the pop-up

menu.
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4. To finalise the renaming operation, press Enter.
PART-III
SHORT ANSWERS:
1. What arethe functions of windows operating system?
Some of the functions of Windows Operating System are:
%+ Access applications (programs) on the computer (word processing, games, spread
sheets, calculators and so on).
Load any new program on the computer.
Manage hardware such as printers, scanners, mouse, digital cameras €tc.,
File management activities (For example creating, modifying, saving, deletingfiles
and folders).
Change computer settings such as colour scheme, screensavers of your monitor, etc.
. Writeanote on Recycle bin?
% Recycle bin isafolder which contains all deleted files and folders having
an opportunity to recover from it.
Write a note on the elements of a window?
Title bar
Menu bar
Tool bar
Scroll bars
Status bar
Borders
Work Space (area) and
Corners
Write atwo waysto create a new folder?
Method I:
Step 1: Open Computer |con.
Step 2: Open any drive where you want to create a new folder.
Step 3: Click on File >New —>Folder.
Step 4: A new folder is created with the default name “New folder”.
Step 5: Type in the folder name and press Enter key.
Method I1:
Step 1: In the Desktop, right click — New — Folder.
Step 2: A Folder appears with the default name “New folder”.
Step 3: Type the name you want and press Enter Key.
Step 4: The name of the folder will change.
. Differentiate copy and move?
COPY MOVE
To move afile or folder, first select the file
To copy the file(s) or folder(s) in the new or folder and then choose one of the
location, navigate to the target location then | following:
do one of the following:

o
o w
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4.

Click Edit -Copy or Ctrl + C or right Click on the Edit =>Cut or Ctrl + X or right
Click = Copy from the pop-up menu. click =>cut from the pop-up menu.
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COPY

MOVE

Click Edit > Paste or Ctrl + V.

Click Edit > Paste or Ctrl + V.

Or Right click - Paste from the pop-up

menu.

Or Right click - Paste from the pop-up

menu.

EXPLAIN IN DETAIL:

PART-IV

1. Explain the versions of Windows Operating System.

Versions

Year

Specific features

Windows

l.x
MICROSOF 1.

WKNDOWS.

« Introductionof GUTin 16 - bit. processor
« Mouse was introduced as an input

device.

Windows
2x

o Supports to minimize or maximize
windows.
« Control pancl feature was introduced

with various system settings and

customising  options.
4

Windows
3x

1992

« Introduced the concept of multitasking,

o Supported 256 colours which brought

a more modern, colourful look to the

interface.

Windows
95

« Introduced Start button, the taskbar,
Windows Explorer and Start menu.
o Introduced 32
focused

bit processor and
more on multitasking.

Windows
08

+ Integration of the Web browser (Internet
Explorer) with the Operating System.

» DOS gaming began to disappear as
Windows based games improved.

» Plug and play feature was introduced.

Windows
NT
MICROSOFLL
WNDOWS

« Designed to act as servers in network.

Windows
Me

7 2 Windows

automated
recovery

« It introduced
diagnostics  and

system
tools.




Windows
2000

« Served as an Operating System for
business desktop and laptop systems.
« Four versions of Windows 2000 were
released: Professional (for business
desktop and laptop systems), Server
(both a Web server and an office server),
Advanced Server (for line-of-business
applications) and Data Centre Server
(for high-traffic computer networks).

Windows
XP

« Introduced 64-bit Processor.
« Improved Windows appearance with
themes and offered a stable version.

Windows
Vista

« Updated the look and feel of Windows.

Windows 7

« Booting time was improved, introduced
new user interfaces like Aero Peek,
pinning  programs to  taskbar
handwriting recognition ctc. and
Internet  Explorer 8.

Windows 8

B Windows 8

« Windows 8 is faster than previous
versions of Windows.

« Start button was removed.

« Windows 8 takes better advantage of
multi-core processing, solid state drives
(SSD), touch screens and other alternate
input methods.

« Served as common platform for mobile
and computer.

Windows
10

« Start Button was added again.

« Multiple desktop.

» Central Notification Center for App
notification and quick actions.

« Cortana voice activated personal assistant.




2. Explain the different ways of finding a file or folder?
Finding Filesand Folders
Y ou can use the search box on the Start menu to quickly search a particular folder or
file in the computer or in a specific drive.
Tofind afileor folder:

= Click the Start button, the search box appears at the bottom of the start menu.

» Typethe name of the file or the folder you want to search. Even if you give the part of
the file or folder name, it will display the list of files or folders starting with the
specified name.

= Thefiles or the folders with the specified names will appear, if you click that file, it
will directly open that file or the folder.

» There isanother option called “See more results” which appears above the sear ch
box.

= If youclick it, it will lead you to a Sear ch Results dialog box where you can click and
open that file or the folder.

Sear ching Files or folders using Computer icon

= Click Computer Icon from desktop or from Start menu.

» The Computer disk drive screen will appear and at the top right corner of that screen,
there is a sear ch box option.

» Type the name of the file or the folder you want to search. Even if you give the part of
the file or folder name, it will display the list of files or folders starting with the
specified name.

Just click and open that file or the folder.

3. Writeaprocedureto create shortcut in Windows OS?

++ Shortcuts to your most often used folders and files may be created and placed onthe
Desktop to help automate your work.
Select the file or folder that you wish to have as a shortcut on the Desktop.
% Right click on the file or folder.
% Select Send to from the shortcut menu, then select Desktop (create shortcut) fromthe
submenu.
A shortcut for the file or folder will now appear on your desktop and you can open it
from the desktop in the same way as any other icon.
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6. INTRODUCTION TO WORD PROCESSOR
PART-I
CHOOSE THE CORRECT ANSWER
1. Which isthe opening screen of OpenOffice?
a. Star desktop  b. Star center C. Star screen d. Star window
2. Which option allows you to assign text, tables, graphics and other items to a key or key
combination

a. Auto format b. Automatic c. Auto text d. Auto graphics
3. Which menu contains the Numbering option.

a. File b. Edit c. Tools d. Format

4. Which isdisplayed at the top most part of the window?

a. Menubar b.Tool bar c. Titlebar d. Format bar

5. Which is changing the default appearance of the text called?

a. Text formatting b. Page formatting

c. Special formatting d. Paragraph formatting
6. The Find & Replace option is available in which menu?

a File b. Edit c. Format d. Tools
7. Which button selects all instances of the search text in the document?
a. Find b. Find All c. Replace d. Replace All

8. What isthe shortcut key to go to the start of the document?
a. Ctrl+ Home b. Ctrl + End c. Home d. End
9. What isthe shortcut key for finding and replacing text in a document?

a Ctrl + F1 b. Ctrl + F c.Ctrl + F5 d. Ctrl +F7

10. What isthe short cut key for Undo?

a Ctrl +E b. Ctrl + U c.Ctrl+Z d. Ctrl +n
PART-II

VERY SHORT ANSWERS
1. Howdoyou insert picturesin toyour document?
Open office Writer has the ability to insert and edit images in a more simple way.
% Place the insertion pointer where you want the image to appear
% Select Insert— Picture — From file
% Theinsert picture dialog box appears where the picture gallery opens from whichthe
desired picture can be selected.
If the picture is not in the gallery, then browse the pictures from the folder, choosethe
desired one and Click on the Open button
% The selected picture isinserted into the document
2. What are the different packagesin OpenOffice writer?
Open Office is a productive office suite with a collection of different software packages
such as
s OpenOffice Writer - Word Processor to create text documents
OpenOffice Calc - Spreadsheet to create worksheets
OpenOffice Base - Database
OpenOffice Impress - Presentation software
OpenOffice Draw - Drawing Software
OpenOffice Formula - Create formulaand equations
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3. What isauto text in writer?

AutoText alows you to assign text, tables, graphics and other itemsto a key or key
combination. For example, rather than typing "TamilNadu" every time you use that phrase,
you might just type "tn" and press F3.

4. How doyou mergecellsin atable?
To merge agroup of cells:
» Select the cellsto merge.
» Right click and choose Cell—» Merge or
» Choose Table —»Merge Cells from the menu bar.
5. Statethe difference between proprietary software and open sour ce softwar €?

proprietary software open sour ce softwar e
Package Developer Package Developer
Microsoft Word Microsoft OpenOffice Writer | Apache
Corporation
WPS Word Kingsoft LibreOffice Writer | The document
foundation
WordPro Lotus Corporation | Abiword Abisource
PART-III

SHORT ANSWERS:
1. What isthe differ ence between moving and copying text?

M oving text Copying text
To move atext from one location to To copy atext from one location to
another another
Select the text to be moved select the text to be copied

Click Ctrl + X or Cut Icond or Edit— Click Ctrl + C or Copy Icon'lEl or Edit

Cut —Copy

The text is removed from the source A duplicate copy of the text is made and
location and placed in the clipboard send to the clipboard

Take the insertion pointer to the new Take the insertion pointer to the new
location to be moved location to be copied

Click ctrl + v or Paste icon ' or Click ctrl + v or Paste icon ' or
edit—paste edit—paste

The required text is moved to new location| The required text is moved to new location

2. What arethedifferent types of orientation?
There are two different orientations:
» Landscape — The width of the document is more than the height. This is best suited
for displaying professional photos, invitations, albums, tables etc.
» Portrait — This isthe most common and default orientation . Here, the height of the
document is more than the width. Normally books, newspapers will be displayed in

this format.
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3. How doyou insert rows and columns?

% Place the insertion pointer in the row or in the column where you would like to add

new rows or columns and right click.

Choose Row —Insert — to insert arow or Column — Insert — to insert a column.

A dialog box will appear, from which you can select the number of rows or columnsto

insert. Y ou can also set the position of the new rows or columns to Before or After

4. What arethe different waysto save a document?

% Y ou can save by clicking File> Save on top left corner and then click File—> Save As
or Ctrl+Shift+S. After that browse the location where exactly you want to save inyour
computer.

% You can also save by just pressing Ctrl + S and then browse the location whereyou
want to save.

% All documents in OpenOffice writer will be stored with .odt extension. Y ou canstore
your OpenOffice document as Microsoft Word document or pdf.

5. Writethe stepsto change the line spacing of text.

» Right click— line spacing, select the type single, 1.5 or double.

= Select the entire document by Edit — Select All

» Format — paragraph

» The paragraph dialog box appears, click Indents & Spacing tab

» Intheline spacing option, select the type and click OK button.

PART-1V

EXPLAIN IN DETAIL

1. What arethe different methodsto change margin in writer?

Page margins are the white space around the top, bottom, left, and right of your

document. Changing or setting page margins in Open office writer can be done in two ways:

= Using the Rulers - quick and easy, but does not have precise values.

» Using the Page Style dialog box — can specify precise values for the margins.
Changing page margins - using Ruler

% The shaded sections of the rulers are the margins.

+ Hold the mouse pointer over the line between the gray and white sections.

% The mouse pointer turns into a double headed arrow.

+ Hold down the left mouse button and drag the mouse to move the margin andrelease

it at the required point.

% The new margin is set.
Using the Page Style dialog box

+ To change margins using the Page Style dialog box

% Right-click anywhere on the page and select Page from the popup menu and select
page tab of page style dialog box.

« Inthe Margins group, specify the values for left, right , top and bottom margins.

% Click on ok button.

2. What isHeader and Footer ? How do you insert page numbersin footer area?

The header is a section of the document that appears in the top mar gin, which

displays the title or chapter name, author name of a document.

e Select from the main menu | nsert ->Header —Default

e The header text area is separated from the normal text area.
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¢ |nthe header area, Enter the text that isto be repeated in all pages or Select Insert —
e Fieds—Title
The footer is asection of the document that appears in the bottom mar gin of the page
which displays the page number, date, time etc. which gets displayed on all the pages
automatically.
e Select from the main menu I nsert — Footer — Default
e Place the insertion pointer in the footer area of the page.
e Select Insert »Fields—Dateto insert date in all the pages.
Inserting and For matting page numbers
The page numbers can be inserted by performing the following steps:
Position the insertion pointer where you want to insert the page number
choose I nsert — Fields —-Page Number
The page number appears with a gray background
Normally, the page numbers appear as 1,2,3....., To change the numbering style, the
following sequence of steps can be performed:
Position the insertion pointer where the page number has to appear
Select Format — page, which will display the page style dialog box.
Select page Tab
In the Layout settings, select the format drop down combo box
Select the desired style and click OK' button.
Write the stepsto Find and Replace a word with another word in OpenOffice
writer?
OpenOffice Writer has a Find and Replace feature that helps to locate for atext inside
a document and replace it with another word.
» Click Edit —» Find & Replace (or) Ctrl + F
Stepstofind & replace a text
% Type the text you want to find in the Sear ch for box. For Example: To search aword
"Bombay" in a document and replace with "Mumbai", enter the word "Bombay" inthe
Search for box.
s To replace the text with different text, type the new text in the Replace with box.
Enter the word " Mumbai" in the Replace with box and Click Find button , to start
the search , the found word is highlighted and the first occurrence of "Bombay" is
highlighted.
To replace text, click Replace button.
The highlighted word is replaced with the word given in the Replace with box.
Click Find All, Writer selects all instances of the search text in the document.
All occurrences of Bombay are highlighted.
Click Replace All button, Writer replaces all matches.
This will replace all occurrences of "Bombay" with "Mumbai".
Enable M atch case to perform the search case sensitively so that uppercase andlower
cases are distinguished separately.
Enable Whole Words only to make the search more specific to words
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4. Explain Page formatting in writer.
Page for matting
The most important thing in aword processor is how to format the page with elements
such as margins, numbering, page layout, headers and footers. Formatting your pages makes
it look more attractive and makes it easier to read.
Changing page size
The default page size in writer is 8.5 x 117, the same as that of a standard A4 printing
paper. However, for different types of documents, you may need to change the page size. To
change the paper size:
» Select the page to be resized
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Figure 6. 26 Page styvle diale I

» Select Format — Page, the page style dialog box appears

» Select Page Tab

» Inthe paper format group, select the format like A4, legal etc

» Or the width and height option can be used to set the pagesize

Changing Page margins

+ Page margins are the white space around the top, bottom, left, and right of your
document.

% Margins let Writer know where to start placing the text at the top of a document, when
to move on to the next page at the bottom, where to start typing text on the left side,
and where to stop and move to the next line on the right.
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% Changing or setting page margins in Openoffice writer can be done in two ways:

% Using the Rulers - quick and easy, but does not have precise val ues.

s Using the Page Style dialog box — can specify precise values for the margins.
Orientation

» Page orientation refers to how the document will be displayed on screenand
printed. There are two different orientations:

% Landscape - The width of the document is more than the height. This is best suited for
displaying professional photos, invitations, albums, tables etc.

s Portrait — Thisisthe most common and default orientation. Here, the height of the
document is more than the width. Normally books, newspapers will be displayed in
this format.

Page colour
%+ Changing the page color is not quite common. To do so, in the Page style dialog
box, select Background tab, In As option click on color and select the “color”
from the color palette or select “graphic” to apply an image as a page

background.
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Borders
+ Borders can be applied to an entire document, an entire page, paragraph, or just to
certain sections of the document. From the page style dialog box, select the Border
tab, the user defined area helps to define the area of borders, the line style of borders,
color of borders can be selected.
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7. WORKING WITH OPEN OFFICE CALC
SECTION - A
CHOOSE THE CORRECT ANSWER
1. Which isthe first electronic spreadsheet?
(A)Excel (B) Lotus1-2-3  (C) Visicalc (D) OpenOffice Calc
2. Which of the following applications was the parent to OpenOffice Calc?
(A)Visicalc (B) LibreCalc (C) Lotus 123 (D) Star Office Calc
3. Grid of cells with a programmable calculator:
(A)Spreadsheet (B) Database (C) Word processor (D) Linux
4. A column heading in Calc is represented using
(A)Number (B) Symbol (C) Date (D) Alphabet
5. Which key is used to move the cell pointer in the forward direction within the worksheet?
(A)Enter (B) Tab (C) Shift + Tab (D) Delete
6. A formulain calc may begin with

(A) = (B) + ©) - (D) All the above
7. What will be the result from the following formula (Assume A1=5, B2=2)? + A1"B2
(A) 7 (B) 25 (C) 10 (D) 52

8. What will be the result from the following expression (Assume H1=12, H2=12)? =
Hl<>H2

(A) True (B)False (C)24 (D) 1212

9. Which of the following symbol is used to make a cell address as an absol ute reference?
(A) + (B) % ©) & (D) $

10. Which of the following key combinations is used to increase the width of thecurrent
column?

(A)AIt + Right arrow (B) Ctrl + Right arrow
(C)Alt + Left arrow (D) Ctrl + Left arrow
SECTION-B

VERY SHORT ANSWERS
1. What arethetypes of toolbar s available in OpenOffice calc?
There are three toolbars available by default. They are:
% Standard Toolbar
¢ Formatting Toolbar
% Formula bar
2. What isa Céell pointer?

s Cdll pointer is arectangle box which can be moved around the worksheet. The
cell in which the cell pointer is currently located isknown as “Active cell”.
When you type any content, it will appear in the active cell.

3. Write about the text operator in OpenOffice Calc.

% In Calc, “&” isatext operator which is used to combine two or more text.
Joining two different texts isalso known as “Text Concatenation” An
expression using the text operator has the following syntax:

text referencel & text reference2
Writethe general syntax of constructing a formulain Calc.
General Syntax of constructing aformulais:
= cell referencel <operator> cell reference2 <operator> ............c......
5. What arethe keyboard shortcutsto cut, copy and paste?
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s Ctrl + X isused to cut the cell
s Ctrl + Cisused to copy the cell
s Ctrl +V isused to paste the cell

6. Can you edit the contents of a cell? If yes, explain any one of the method of

editing the cell content.

 Yes, we can edit the contents of a cell.

s Using keyboard, after selecting the cell, Press the F2 key and the cursor is placed at
the end of the cell. The use the keyboard arrow keys to move the cursor throughthe

text in the cdll.

7. What are the options available in “Insert Cells” dialog box?
There are four options available in Insert cells

+»+ Shift cells down
s Shift cellsright
< Entirerow
+» Entire Column

8. Match thefollowing

A B
Cut, Copy, Paste Standard Toolbar
Cell Pointer Active Cell
Selection Mode Status Bar
$AS5 Absolute Cell

9. Definethefollowing (i) Text Operator (ii) Rows and Columns of spreadsheet

(i) Text Operator

% In Calc, “&” is a text operator which is used to combine two or more text.
Joining two different texts is also known as “Text Concatenation” An

expression using the text operator has the following syntax:
text referencel & text reference2
(i'Rows and Columns of spreadsheet
e A row isahorizontal group of values within atable. It contains values for multiple
fields, which are defined by columns. The rows are numbered from 1, 2, 3....
OpenOffice Calc version 4.1.5 contains 10,48,576 rows.
e A columnisavertical group of values within atable. It contains values from asingle
field in multiple rows. Each columnislabelledas A, B, C,D ..... AA,AB, AC ....It

contains 1024 columns.

10.Differ entiate between Copy -Paste and Cut-Paste

Copy —Paste

Cut-Paste

Select the cell or group of cells you want to
copy, then using Select Edit— Copy or
Click “Copy” icon from the standard
toolbar or Press Ctrl + C

Select the cell or group of cells you want to
cut, then using Edit — Cut or Click “Cut”
icon from the standard toolbar or Press Ctrl
+ X

Copy leavesthe cell information in its
original location and makes copy of the cell
information when pasted it

But in Moving it removes the information
and pastes it in another location

Move the cell pointer to the cell in which
you want to paste. Edit — Paste or Click

Move the cell pointer to the cell in which
you want to paste. Edit — Paste or Click
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“Paste” icon or Press Ctrl + V “Paste” icon or Press Ctrl + V

PART-III
SHORT ANSWERS:
1. Writeashort note on OpenOffice Calc.
e OpenOffice Calc isa popular open source spreadsheet application maintained by
Apache Foundation.
e StarOffice calc was the parent application of OpenOffice Calc which wasdeveloped
by a German Company namely, Star Division in 1985.
e Calc isthe spreadsheet component of OpenOffice. Y ou can enter any kind of datain a
spreadsheet and then manipulate this data to produce certain results.
2. Write about inserting columns and rowsin Calc.
Inserting Rows - In Calc, we can insert a new row anywhere in the worksheet.
Step 1: Select the row where a new row to be inserted.
Step 2: Right-click on the row number, a pop-up menu appears
Step 3: click “Insert Rows” option from the menu.
Now, anew row will be inserted to above the current row. Insert > Rows
command is used to insert a new row.
Inserting a Column - In Calc, we can insert a new column anywhere in the
worksheet.
Step 1: Select the column where a new column should be inserted.
Step 2: Right-click on the selected column name that you selected. A pop-up menu
appears.
Step 3: click the “Insert Columns™ option from the menu.
Now, anew column will be inserted to the left of the current column. A new
column can also be inserted using Insert - Columns command.
3. Differentiate Deleting data using Backspace and Delete

Backspace Delete

Backspace key is used to delete the character | Delete key is used to delete the character
left of the insertion pointer of the cell. right of the insertion pointer of the cell.

4. Write any three for matting options.
Formatting Option Keyboard Shortcut Description
Bold Ctrl + B Used to make the data as Bold
Italic Ctrl + | Used to Italicize data
Underline Ctrl + U Used to Underline the data

5. Incel A1=34 A2=65 A3=89 writethe formulato find the aver age.
To find the average, using anyone of the following way:
» = AVERAGE (A1:A3) = 62.7%
PART-1V
EXPLAIN IN DETAIL:
1. Explain about changing the column width in Calc.
Resize the width of a column using the mouse

% Usethe right hand border to increase or decrease the width of a column.
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++ Position the cursor on the right hand border of the column letter box, until you seea

double headed arrow.

¢ Hold down the left hand mouse button and drag the border to the left or right to make

X/

the column narrower or wider as required.
% Asyou carry out this action, the width of the column displays.

|~ wWidth: 1.16 = ¢
|I =Y I:Q-:;'.‘{}E |
0
2
=
s

Using the mouse to widen a column
Resize one or more columns using For mat
Select the column(s) whose width you wish to change
Select Format 7 /Column “17Width...
The Column Width dialog displays

0’0

7
’0

*,

0’0

width  [p.8g" S oK ';
[+ Default value Cancel
% Help

«» Enter avaluein the Width window or check the Default value check box to select the

default column width.
% Click OK.
% The selected columns display with the new width.
2. Write the steps to generate the following series. 5, 10, 20 ..... 2560
STEPS TO GENERATE THE SERIES 5,10,20,...2560
» Select the required number of cells to generate the series.
» Click EDIT=HILL, the Fill Series dialog box appears as shown below,

Fill Series

Dhirecticn Series type Tis I | o
i Dronwm Lin=ar
® Giswih o [ Cancel
Ll Data Tk |
- - Help
LuraFill
Start value 5
Eniol walie 25500
[ngremert 5

) EJE E_:

» Select the Direction as Down in fill series dialog box.

» Select the Series type Growth.

> Initial value of the series 5 should be typed in Start Value box.

» Maximum value of the series 2560 should be typed in End Value box.
» The value 5 should be typed in Increment box .
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» Click OK. Now the series is generated as given below,

3. Read thefollowing table

=

A

10
20
40
80
160
320
G540
1280
2560

A
Year

B

Chennai

C

Madurai

D
Tiruchi

E

Coimbatore

2012

2013

1500
Ll

1250
1000

1000
950

00
350

L e | | B

1014
2015

15900
1850

1320
1415

750

&20

300
200

]

016

1950

1240

920

50

Above table shows the sales figures for “Air Cooler” sold in four major cities of TamilNadu
from the year 2012 to 2016. Based on this data, write the formula to calculate the following.

(1) Total salesin the year 2015.
(2) Total sales in Coimbatore from 2012 to 2016.
(3) Total salesin Madurai and Tiruchi during 2015 and 2016.
(4) Average salesin Chennai from 2012 to 2016
(5) In 2016, how many “Air Coolers” are sold in Chennai compared to Coimbatore?

ANSWER:

SL.NO

QUESTION

FORMULA

ANSWER

1

Total saesinthe
year 2015.

=SUM (B5:E5)

4285

2

Total salesin
Coimbatore from
2012 to 2016.

=SUM(E2:E6)

1600

Total salesin
Madurai and
Tiruchi during 2015
and 2016.

=SUM(C5:D6)

4395

Average salesin
Chennai from 2012
to 2016

=AVERAGE(B2:B
6)

1760

In 2016, how many
“Air Coolers” are
sold in Chennai
compared to
Coimbatore?

=B6-E6

1700
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8. PRESENTATION BASICS
PART-I
CHOOSE THE CORRECT ANSWER
1. Which is used to move quickly from one slide to another?

A) Compass B) Navigator C) Fill color D) Page border
2. Which isthe shortcut key to view the slideshow?
A) F6 B) F9 C)F5 D) F10

3. In Impress, which views shows thumbnail versions of all your slides arrangedin
horizontal rows.

A) Notes  B) Outline C) Handout D) Slide Sorter
4. |dentify the default view in Impress.
A) Normal B) Slide Sorter ~ C) Handout D) Notes

5. Which menu contains the Slide Transition option?
A) SlideShow B)View C)Tools D) Format
6. Identify the extension of the Impress presentation.
A) .odp B) .ppt C) .odb D) .ood
7. In presentation tools, the entry effect as one slide replaces another slide in a slide show.
Identify the option that suits after reading the statement.
A) Animation B) Slide Transition C) Customanimation D) Rehearse Timing
8. Vanya has made a presentation on “Global Warming”. She wants to progress her slide
show automatically while speaks on the topic in the class. Which features of I mpress would
she use?
A) Custom Animation  B) Rehearse Timing
C) Slide Transition D) Either (a) or (b).
PART-II
SHORT ANSWERS:
1. What isthe difference between a slide and a slide show?

Side Slide Show
A slide is an editable format that contains | A slide show is a combination of a number
different element like text, tables, charts, of dlides that run one after the other
clip-art etc.

2. How many in-built slide layouts does impress consist of?
+ In-built the open office impress consist of 12 different layouts of slides.
3. What do you under stand by a presentation?

% A presentation program is a software package used to show information in the form
of a slide show.

It has three mgjor functions: an editor that allows text to be inserted and formatted, a
method for inserting and manipulating graphic images, and a slide-show system to
display the content.

4. Defineatemplatein Impress.

% A template is a premade design you can use to lend cohesiveness, visual
organization and appeal to your presentation. Even though individual slides can
have different layouts and graphics, templates help the whole presentation go
together as an attractive package.

5. What do you understand by the slide layout?
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+ Slide layouts are pre-packaged layouts which contain formatting, positioning, and
placeholders for all of the content that appears on a slide.
+ Placeholders are the containers in layouts that hold such content as text, tables, charts,
SmartArt graphics, movies, sounds, pictures, and clip art.
PART-III
SHORT ANSWERS:
1. How many types of views are provided by Impresstoits users?
There are 5 types of views are provided by Impress. They are
Nor mal view - Normal view isthe main view for creating individual slides.
Outline view - Outline view shows topic titles, bulleted lists and numbered lists for
each slide in outline format.
“ Notes view- Notes view lets you add notes to each slide that are not seen whenthe
presentation is shown.
% Slide Sorter view - Slide Sorter view shows a thumbnail of each slide in order.
+ Handout view - Handout view lets you print your slides for a handout.
2. Who uses the presentation software and why?
% Businesses and professional firms use presentations to inform, educate, motivateand
persuade internal and external audiences.
% They build presentations into sales, training and internal communication programs,
using the power of words and images to engage their audience and retain attention.
Presentation software is used to create presentations, quizzes, e-learning packages and
multimedia products.
Define the Slide Sorter view and its significance.
The Slide Sorter view contains all of the slide thumbnails.
Use Slide Sorter view to work with a group of slides or with only one slide.
Use Slide Sorter view to reorganize, insert, delete and copy the slides, produce a timed
slide show or add transitions between selected slides.
What isa Normal view? Explain.
Normal view isthe main view for creating individual slides.
Use this view to format and design slides and to add text, graphics and animation
effects.
% There are two ways to place a slide in the Slide Design area of the Normal view:
clicking the slide thumbnail in the Slides pane or using the Navigator.
5. How aretransition effects helpful in creating aneffective presentation in
I mpress?
+« Slide transitions are the effects that occur when you move from one slide to the next
during a presentation.
% You can control the speed, add sound, and customize the properties usingthe
transition effects.
% Y ou can also choose between an automatic or manual transition.
PART-1V
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EXPLAIN IN DETAIL:
1. Valarmathi’s teacher asks her to create a presentation in OpenOffice Impress. As
Valarmathi has never worked in Impress before, help her to perform the
following tasks:
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(a)She wants that except for thefirst dlide, all the slides should have the
same design. For this, what does she need to do?

v" Create the presentation with same design for al slides using master page option, by
clicking YES in Page Setting dialog box

I e b A e ener e

R 659 15 %

v Click th'e Master slide and choose Format - Page menu. The Page setup dialog box
appears on the screen.

Size
21 Qiriginal Aidsn

Posithon
P = -

I'I' e .'I'

b~

Mo set 0 3%

W ot 0% =
+ Tilm I

CHf s e
P

el 0 %%

| L || Cancel Hela Besat |

v" Click Background and choose any one of the Fill option (Colour, Gradient, Bitmap,
Hatching) for changing the background of the master slide.
v' The Page Setting dialog box appears on the screen,

Page Settings
@ Background settings for all pages?
[ de J[ o |

v" Click NO in the Page Setting dialog box.
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b)T o easily communicate with her audience, she wantsto provide them with a hard

copy of the slides of the presentation. What should she createfor it?

v Handout view is used for setting up the layout of your slides for a printed handout.
c)She wantsto insert some pictures and movie filesin some slides. How can shedo
that?

v' Select the slide to insert the picture.

v" Choose | nsert-> Picture - From File option, and choose the required picture that hasto

be inserted into the dslide.
d) Suggest her view that would be the most suitable for showing the presentation to
the audience.

v Use Slide Show view to deliver your presentation to your audience. Slide Show view
occupies the full computer screen, exactly the way your presentation will look on abig
screen when your audience sees it.

e)To make her presentation more attractive, she wantsto add some effectsin it.
How can she doit? Suggest.

v To make her presentation attractive, she needs to add animation and transition effects
to the slides.

2. Explain how a presentation can help a salesperson to promote his’her products.

» Presentation is helpful for a sales person to promote his/her products effectively.

> Presentation will give visual video, pictures to understand a goodness of the product.

» By using presentation, sales person can make audience to understand easier and he can
get more response from the people.

Presentation help sales person to present prospect challenges easier.
Sales person can explain with physical demonstration by shockinganimations. It helps
to increase the sales.

Y V
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Sivabalan created a presentation to be shown at hisschool’s Annual Function.
Just 5 minutes befor e the presentation, he noticed that he has misspelt the name
of the school, which isappearingin all the 30 slides of the presentation. How can
herectify thismistake in all the slidesin one-shot?

The slide master will be helpful in this situation. Select the Master slide,

Choose Edit — Find & Replace option from the menu bar. The Find & Replace
Dialog box appears on the screen,

rFind & Replace @ﬁ
Search for
| <] [ End |
Replace with | Replace |
| Replace All |

Match caze

Whole words only

| More Options ¥ | | Help | | Close |

% Inthe search for box type the misspelt word.

% Type the correct word in the Replace with box.

¢ Click the Find option to find the misspelt word.

% Click the Replace All option to replace the correct word in all the slides. Y oucan
see the replacement in all the slides.

L ist some advantages of using templates.

% Professional Graphic Design: Templates will give professional Graphic Design
which helps you to create branded PowerPoint presentation.

+ Branding: Templates can easily be modified by changing colors, fonts, graphics,
or even add your own logo to the mix.

s Speed: With agood starting point in each slide, your presentation is madein a
snap.

% Quick Customization: It’s much easier to edit the template in its original form,
not as a copy of a copy.

+ Consistency: A consistent design scheme will avoid jarring transitions and the
sneaking suspicion that the presentation was pasted together as a ransomnote.
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9. INTRODUCTION TO INTERNET AND EMAIL
PART-I
CHOOSE THE CORRECT ANSWER:
1. What isthe expansion of WLAN?
a) Wireless L ocal Area Networ k b) Wired local Area Network
c) Wireless Local Area Netware d) Wireless Area Netbande
2. Range of Campus Network is
a)10KM b)5KM ¢)25KM d)20 KM
3. Each computer on net is called

a) host b) server  c) workstation d) node
4. Theinternet is governed by
a) ICANM b) ICANN c) ICMA d) ICNNA

5. Expansion of W3C
a) World Wide Web Consortium  b) Wide World Web Consortium
c) World Web Wide Consortium d) World Wide Web Consortum
6. W3C was established in 1994 by
a) Tim Berners-Lee b) Tim Burnard Lee c) KimBerners  d) Kim Bernard Lee
7. Hotspot uses which type of network services?
a) LAN b) PAN c) WLAN d) CAN
8. USB WiFi adapters are often called as
a) Data Card b) Pen Drive c) Dongles d) Memory Card
9. Looking for information on the internet is called
a) Surfing b) Searching c¢) Finding d) glancing
10. Safari web browser was developed by
a) Google b) Apple c) Microsoft d) Linux Corpn.
11. How many types of websites are available?
a3 b) 2 c)4 d) 6
PART-II
VERY SHORT ANSWERS:
1. Namethetwo important protocolsfor internet?
% Theinternet uses TCP/IP(Transmission Control Protocol/ Internet Protocol ) to
transmit data via various types of media.
s TCP/IP is not a single networking protocol — it isa suite of protocols named after the
two most important protocols or layers within it — TCP and IP.
s Aswith any form of communication, two things are needed: a message to transmit and
the means to reliably transmit the message.
% Theinternet protocol (IP) addressing system is used to keep track of the millions of
USers.
2. What isa network?
+ A network isa collection of interconnected devices (such as computers
printers).
3. What istherole of ICANN?
% Internet Corporation for Assigned Names and Numbers (ICANN)
administers the domain name registration. It helps to avoid aname
which is already registered.
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4. What is a search engine?

% A search engine is a software system that is designed to search for
information on the World Wide Web. Examples of popular search
engines are Y ahoo, Lycos, Altavista, Hotbot, Google and Askjeeves.

5. What isa browser?
s A browser is used to access websites and web pages whereas a search engine
Issued to search for particular information. Internet Explorer, Chrome, Firefox,
Safari, and yahoo are the most popular web browsers while Google and Y ahoo
are the most popular search engines.
6. What are the components of URL addressing?
% A webpage is a page of a Website. Every page has a unique address called the
Uniform
¢ Resource Locator (URL). The URL locates the pages on the internet.

URL

Uniform Resource Locator

A~

typarToxt Tramsler:  [moam -

7. What is a website?

% A website is a collection of webpages. For example if there is a company that
owns sricompany.com then this website will have several Webpages like Home,
About Us, Contact Us, Testimonials, Products, Services, FAQ’s, and others.
The first page of the website is called a Home Page. All of these pages together
make up a Website.

8. What isCC and BCC in an email?

% The CC (Carbon Copy) field allows you to specify recipients who are not direct
addressees (listed inthe "To" field). Thisfield is optional.

% The BCC (Blind Carbon Copy) field issimilar to CC, except the recipients are
Secret.

« Each BCC recipient will receive the e-mail, but will not see who else received acopy.

% The addressees (anyone listed in the "To" field) remain visible to all recipients. This
field is optional.

9. What is a Static web Page?

s Web pages are called Static websites as they remain the same whenever it is
visited. Examples of static Websites are website owned by Small business
organizations, School websites etc.

10.What is a Dynamic web page?

s Websites that displays marks of Public Examinations and Entrance
Examinations changes when different register numbers are given. Suchwebsites
are caled as Dynamic Websites. Eg,. Websites of Government and Entrance
Exams.

11.What ar e the benefits of e-gover nance?

Benefits of E-gover nance
+* Reduced corruption

43




)
0‘0

X3

*

X3

*

)
0‘0

High transparency

Increased convenience
Reduction in overall cost.
Expanded reach of government

12.What is Phishing?

s Phishing scams are fraudulent attempts by cybercriminals to obtain private
information. Phishing scams often appear in the guise of email messages
designed to appear as though they are from legitimate sources.

PART-II

SHORT ANSWERS:

1.
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0’0

K/
0’0

0

What isTCP/IP ?
The internet uses TCP/IP(Transmission Control Protocol/ Internet Protocol ) to
transmit data via various types of media.
TCP/IP is not a single networking protocol .As with any form of communication, two
things are needed: A message to transmit and the means to reliably transmit the
message.
The internet protocol (1P) addressing system is used to keep track of the millions of
users. Each computer on net is called as host. Theinternet isthe most cost-effective
method of communications in the world.
Write a note on Hotspot inter net service.
% Hotspots are sites that offer Internet access over a wireless local area network
(WLAN) by way of arouter that then connects to an Internet service provider.
 Hotspots utilize Wi-Fi technology, which allows electronic devices to connect
to the Internet or exchange data wirelessly through radio waves. Hotspots can
be phone-based or free-standing, commercial or free to the public.
Differentiate Data Card and Dongles
' Dongle Data Card \
Refers to any removable component used | It is a removable electronic card which

for enabling extra security. USB Dongles | is used for storing for data. Types of |

can be divided into datacard are

|«  WiFi Dongles « Expansion Card
» BlueTooth Dongle + Memory Card or Flash Card
+ Memory Dongle » Identification Card

Write a note on two access methods of connecting to inter net.
Indirect Access Thisis most common method used in home and office networks. The
device e.g. computer connects to a network using Ethernet or WiFi and the network
connects to the Internet using Asymmetric digital subscriber line ADSL (cable or
fibre)
Direct Access Thisis most common method used when travelling. The device e.g.
smart phone connects directly to the Internet using 3G/4G mobile networks/public
WiFi.
Differentiate browser and a sear ch engine with suitable examples.
% Search Engine: “A search engine is a software system that is designed to search
for information on the World Wide Web”.
“» Examples of popular search engines are Y ahoo, Lycos, AltaVista, Hotbot,
Google, askjeeves.
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s Browser : “A browser is used to access websites and web pages whereas a search
engine issued to search for particular information”
s Examples: Internet Explorer, Chrome, Firefox, Safari, and Google and Y ahooare
the most popular search engines.
6. Differentiate Website and Webpage.

Webpage Website
Consists of a Single document displayed by | A collection of multiple documents
| a browser displayable by a browser
Shares a unique domain name Has its own unique domain name
Makes up a website Contains one or more webpages

7. What isthe difference between Static and dynamic web page.
i Static Web Page Dynamic Web Page

, : = [he content and layout may change during
I'he content and layout of a web page is fixed

run time

’ YT Databases is used to generate dynamic
Static Web pages never use databases = :
|

| Static web pages directly run on the | Dynamic web pages runs on the server

content through queries

browser and do not require any server side | side application programs and displays

application program the results

amic web page development requires
Dynami b page development requir

Static Web pages are easy to develop

programming skills

8. What are Advantages of email?
e Freedelivery - Sending an e-mail isvirtually free, outside the cost of Internet service.
There is no need to buy a postage stamp to send a letter.
e Global delivery - E-mail can be sent to nearly anywhere around the world, toany
country.
e Instant delivery - An e-mail can be instantly sent and received bythe recipient over
the Internet.
e Fileattachment - An e-mail can include one or more file attachments, allowing a
person to send documents, pictures, or other files with an e-mail.
e L ong-term storage - E-mails are stored electronically, which allows for storageand
archival over long periods of time.
e Environmentally friendly - Sending an e-mail does not require paper (Paperless)
cardboard, or packing tape, conserving paper resources.
PART-1V
EXPLAIN IN DETAIL:
1. Explain any five types of inter net services.
Wireless
* Radio frequency bands are used in place of telephone or cable networks. One of the
greatest advantages of wireless Internet connections is the "always-on" connection that
can be accessed from any location that falls within network coverage.
Mobile
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% Many cell phone and Smartphone providers offer voice plans with Internet access.
Mobile Internet connections provide good speeds and allow you to access thelnternet.
Hotspots
% Hotspots are sites that offer Internet access over awireless local area network
(WLAN) by way of arouter that then connects to an Internet service provider.
% Hotspots utilize Wi-Fi technology, which allows electronic devices to connect to the
Internet or exchange data wirelessly through radio waves.
Broadband
s This high-speed Internet connection is provided through either cable or telephone
companies. One of the fastest options available, broadband Internet uses multiple data
channels to send large quantities of information. Broadband Internet connections such
as DSL and cable are considered high-bandwidth connections.
DSL
s DSL, which stands for Digital Subscriber Line, uses existing 2-wire copper telephone
line connected to one's home so service is delivered at the same time as landline
telephone service. Customers can still place calls while surfing the Internet.
Cable
s Cable Internet connection is a form of broadband access. Through use of a cable
modem, users can access the Internet over cable TV lines. Cable modems can provide
extremely fast access to the Internet.
Satellite
“ In certain areas where broadband connection is not yet offered, a satellitelnternet
option may be available. Similar to wireless access, satellite connection utilizes a
modem.
|SDN
+ ISDN (Integrated Services Digital Network) allows users to send data, voice and video
content over digital telephone lines or standard telephone wires. The installation of an
ISDN adapter is required at both ends of the transmission—on the part of the user as
well as the Internet access provider.
2. Explain any five inter net applications with suitable examples.
1. Internet telephony Internet telephony (e.g. Skype) is another commoncommunications
service made possible by the creation of the Internet. Vol P stands for V oice-over-Internet
Protocol, referring to the protocol that underlies all Internet communication.
2. Job sear ch Nowadays, many people search for their jobs online as it is quicker. Some of
the web sites providing this service are naukri.com, monster.com, summerjob.com,
recuritmentindia.com etc.
3. Online Shopping The internet has also facilitated the introduction of a new market
concept consisting of virtual shops.
4. Stock mar ket updates Selling or buying shares sitting on computer throughinternet.
Several websites like ndtvprofit.com, moneypore.com, provide information regarding
Investment.
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5. Travel: One can use internet to gather information about various tourist place .it canbe
used for booking Holiday tours, hotels, train, bus, flights and cabs. Some of the web sites
providing this service are goibibo.com, makemytrip.com, olacabs.com.
6. Resear ch Research papers are present online which helps in the researcher doinga
literature review
7. Video conferencing: It enables direct face-to-face communication across networks via
web cameras, microphones, and other communication tools.
8. e-commer ce e-commerce (electronic commerce or EC) isthe buying and selling of goods
and services, or the transmitting of funds or data. Largest e-commerce companies in India
are Flipkart, Snapdeal, Amazon India, Paytm.
9. Online payments The rising boom of online payments in India has given way to many
new entrants in the industry such as Paytm etc who are majorly wallet driven payment
companies.
10. Social Networ king: Social networking isthe use of internet-based social media
programs to make connections with friends, family, classmates, customers and clients.
Examples of social networking includes Facebook
11. Voicemail: Voicemail isa system of sending messages over the phone.
12. Chatting On the Internet, chatting istalking to other people who are using the I nternet at
the same time you are.
13. e-banking : E-banking (Online banking) , also known as internet banking, itisan
electronic payment system that enables customers of a bank or other financial institutionto
conduct arange of financial transactions through the financial institution's website. The
online banking system will typically connect to or be part of the core banking system
operated by abank and isin contrast to branch banking which was the traditional way
customers accessed banking services.
14. e-lear ning:-e-Learning are courses that are specifically delivered viathe internetto
somewhere other than the classroom where the professor isteaching. It isnot a course
delivered viaa DVD or CD-ROM, video tape or over atelevision channel.

3. Writeanote on any five Internet browsers other than that given in the book.

e Looking for information on the internet is called surfing or browsing. To browse the
internet, software called the web browser or browser is used.

e E-commerce, social media, and many other things we take for granted today would be
Impossible without internet browsers. A web browser translates HTML documents of
the website and allows viewing it on the screen.

Familiar | nter net Browser
s Google Chrome isa freeware familiar web browser developed by Google I nc. It

Is best for its speed, simplicity, security, privacy and customization features.
Google Chrome supports on Android 4.0 or higher, i0S 6.0 or higher, Mac OSX
10.6 or higher and Windows (XP sp2 or higher) and Linux system.

s MozlaFirefox isa free and open source web browser developed by Mozilla
Foundation and M ozilla Cor poration. FireFox isdefault browser in Ubuntu . It
supports Windows, Mac OS X, Linux and Android system.

% Internet Explorer commonly known as Microsoft Internet Explorer or Windows
Internet Explorer isthe first or default browser for a Windows PC. It is devel oped
by Micr osoft.

« Safari isaweb browser developed by Apple Inc. and comes with OS X and iOS.
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Some version of safari browser also supports in Windows Operating System.
Exclusively used in Apple M ac system.

4. Explain the do’s and don’t of safe surfing on internet.
Following isthe do’s and don’t of safe Surfing on Internet

K/
0’0

L 4

0

L 4

D

*,

.0

Don’t give out your personal information — Don’t put personal details such as your
home address, telephone numbers or parent’s work address online as cybercriminals
can use this information to create a fake profile with your details

What goes online stays online — Use privacy settings to make sure only your friends
and family can see photos you post. Avoid posting holiday plans as criminals have
been known to track your movements

Check your security and privacy settings — Make sure your social network privacy
settings are secured so only your friends can see your personal information and use
your privacy settings to restrict who can see your posts, videos and photos

Password safety — Sharing your password with your parents is a sensible idea, but
avoids sharing your password with your friends, even if they promise they won’t tell
anyone! Also, when setting your password, make sure it isn’t something people may
guess such as your pet’s name. Use a mixture of letters, numbers and upper and lower
case characters

Always protect your mobile device — Make sure your mobile phone is pin-protected so
all your personal information stored on it is safe. Download a security app which
allows you to remotely wipe any personal data, should your mobile be lost or stolen
Don’t talk to strangers online or offline — Don’t meet up with strangers and let your
parents know if a stranger has tried to get in contact with you online,

Listen to the adults who know — Adults will always be worried about you. Help set
their mind at rest and avoid chatting online with strangers.

Be wary of unsecured or unknown websites — When shopping online, usereputable
and known retailers.

Be careful what links you click on — Avoid clicking links in an email, Instant M essage
or on your social network unless you are sure the message is from someone youknow.
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10. HTML - Structural Tags

PART-
CHOOSE THE BEST ANSWER:
1. HTML isacronym for
(@) Hyper Transfer Markup Language (b) Hyper Text Markup Language
(c) Hyper Transfer Makeup Language (d) Hyper Text Makeup Language

2. The coded HTML keywords that indicates how web browser should format and display
the content is called.......

(@) Tags (b) Attributes (c) Headings (d) Body

3.Which of the following isa special word used inside tag to specify additional information
to the tag?

(@) Tags (b) Attributes  (c) Headings (d) Body

4. HTML tags should be specified within:

@[] (b){} © () (d) <>
5. An HTML document is bounded within apair of ..... tags

(@) <body> ....... </body> (b) <title> ....... </title>

(c) <html> ....... </html|> (d) <head> ...... </head>

6. Which of the following symbol is used to define a closing tag?
(@ <> (b) % (©/ (d)\

7. Which section of the browser window displays the main contents?

(@ Head (b)Body (c) Title (d) Heading

8. Which of the following tag isa structural tag?

(@ <htmlI> (b)<hl> (c) <br> (d) <p>

9. In HTML, colours are represented as

(a) Binary values (b) Octal values  (c) Decimal values (d) Hexadecimal
values

10. Which of the following symbol is used to prefix with hexadecimal value representing
colour in HTML?

(&) % (b)# ()@ (d) &

11. Which of the following attribute is used to change text colour within body tag?

(a) bgcolor (b) background (c) text (d) color

12. Within body section, which of the following attribute is used to set top margin?

(@ margin  (b) top (c) topmargin (d) leftmargin

13. How many levels of heading tags available in HTML?

(a) 6 (b) 4 ()8 (d)3
14. Thetag used to insert aline break:
(@ <h1> (b)<br> (c) <html> (d) <p>

15. Thetag used to define a paragraph in HTML.:
(@ <para> (b)<p>  (Q<g>  (d) <br>

PART - 11
VERY SHORT ANSWERS:

1. Sandhiyaiscreating a webpage. Sheisentering HTML code on her computer. In
between, she keeps pressing “Refresh” / “Reload” button on her browser. What
isthe purpose?

Reload / Refresh the changes:
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» After modify and save the source file, minimize your source file. Go to the
browser. Click Refresh (Internet Explorer) / Reload Current Page (Firefox) /
Reload this page (Chrome) icons on the address bar. Press Ctrl + R or F5 will
be used to refresh / reload the modifications.

2. Explain with the help of an example the difference between container and empty

elementsof HTML.

» Container Elements: The tags which are required opening and closing is known as

container elements or tags. For example: <html>, <body>, <title>, <p> etc.,

» Empty Elements: The tags which are required only opening tag is known as empty

elements or tags. For example: <br>

3. What isthe wrong in the following coding?
<html|>
<my web page>
<title> Welcome to my web page
</head>
<ftitle>
SOLUTION:
<html>
<head> <title>my web page</title>
</head>
<body> Welcome to my web page</body></html>

4. How do you define commentsin HTML?

» Comments are used to describe the page or provide some kind of indication of the
status of the page. The tag <!> is used to create comments. Comments never show up
onscreen. Comments can be placed anywhere in HTM L document.

The general form of comments: <! Comments>
How do you include an image as your web page background?
An image or picture can be applied as background to a webpage. When you insert an
image as background, the text will be displayed on top of the image. Background
Images can be a texture or bitmap or even a photo.
» Thetag to apply an image as background:

<body background = “image name_ with extenstion”>

PART — Il

vV 9 v

SHORT ANSWERS:
1. Explain the attributes available with <body> tag.
(i) Background Colour: bgcolor = color
» By default all the browsers display the text on white background. However, the
background color of the browser can be changed by using bgcolor tag.
» The tag to change background colour: <body bgcolor = color _name/color _code>
(ii) Body text Colour: text = color
» The default text colour of body section is“black™, it is often called as automatic color.
text attribute within body tag is used to change the text colour.
» The tag to change body text colour: <body text = color_name/color _code>
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(iif) Background image: backgr ound=image
» Animage or picture can be applied as background to a webpage. When you insertan
Image as background, the text will be displayed on top of the image. Background
Images can be a texture or bitmap or even a photo.
» Thetag to apply an image as background: <body background =
“image name_ with extenstion”>
2. What arethe attributes available in <html|> tags?
<html> tag has two attributes viz. dir and lang to specify the text direction and
language setting respectively
Dir:
> dir attribute specifies the direction of the text to be aligned within the entiredocument.
It isglobal attribute.
> Itr isthe default value
» rtl isused for Arabian languages.
L ang:
» lang attribute specify the language used with in the document. Predefined language
code will be used for this purpose.
» Malayalam — ml; Kannada — kn; Hindi — hi; French — fr; German — de.
3. How doyou view the sour cefile?
Right click on the browser
Select View Page Sour ce (Firefox and Chrome) / View Sour ce (I nter net Explorer)
or Press Ctrl + U (all browser)
Source file will be displayed.
In Internet Explorer, View — Sour ce is also used to open source file.
4. How doyou saveafileasHTML file?
e Click File — Save (or) Press Ctrl + S
e Save as dialog box appears as shown in the Figure
e In “File Name” text box, type a file name with .htm or .html extension. Select “All
Files” from “Save as type” list box. Click “Save” button.
PART-1V

R/ R/
0’0 0’0

R/ R/
0’0 0’0

EXPLAIN IN DETAIL:
1. WriteaHTML program to display your school name and addr ess using heading

level tags.
<html>
<head>
<title>MY SCHOOL</title>
</head>
<body>
<h1>BLUE STARS HIGHER SECONDARY SCHOOL</h1><br>
Main road, <br>
Thirukuralar Nagar, <br>
Arumparthapuram, <br>
Villianur-605110.
</body>
</html>
OUTPUT:

51




bile [d& Yew Hipory Hoolomarks Jools  Hele
E ol Al A e HIME Dbz p A M FLE him]
& Mast Vigtsd Gettivey Stated Labess Hegdlines
., Peoisleim loading gage . T AYE Drdwa Seouity - Ged this Blerc.. = g Wbk de Jaws, Sbweriight, Aadebe Bor.

BLUE STARS HIGHER SECONDARY SCHOOL

Auflain o
[eroloealar Mages

Amismparhogirem
Vilkamr 50151 10

2. Writethebasic structureof aHTML program.
s An HTML document contains the text of the page itself and HTML tags, which

defined the structure and appearance of the document. It also contains
hyperlinks to other pages or to include multimedia elements such as audio,
video, animations etc. Entire HTML document is bounded within a pair of
<html> and </html> tags.

All HTML documents should follow this general format

<html>
<head>
<title> My First Web Page </title>
</head>
<body>
Thisismy First Web Page
</body>
</html|>
s HTML tags are generally have an opening and closing tag surrounding the text they
affect. Opening tag turn-on a feature such as heading, bold, center etc., and closing tag
turn-off its features. Opening and closing tags are the same name, but closing tag
name preceded by a slash ( /). For example, <html> is an opening tag, </html> is a
closing tag.
« Every web document has two sections viz. Heading Section and Body Section. The
heading section is used to show the title of a webpage in title bar or tag heading in
browser. The head section should begin with <head> tag and end with </head> tag.
The tag <title> is used to specify the title of the webpage.
% The body section is used to display the main content on the browser window. The
body section should defined within <body> and </body> tags. Whatever the text you
specify between these tags will display on the browser window.
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11.HTML - Formatting text, Creating Tables, List and Links
PART-I
CHOOSE THE BEST ANSWER:
1. Which of the following tags are called as physical styletags?

(A) <html>, <b>, <br> (B) <b>, <br>, <u>

(C) <A>, <b>, <i> (D) <b>, <i>, <u>

2. Which feature is used to call attention to the reader?

(A) Highlight (B) Bold  (C) Italics (D) Underline
3. Thetags <sub> and <sup> used for:

(A) Subject and Super (B) Subscript and Super

(C) Subject and Superscript (D) Subscript and Super script
4. A named set of certain style of character and number is:

(A) Style (B) Character (C) Font (D) List
5. Pick odd one from the list
(A) <tr (B) <th> (C) <dh> (D) <td

6. Match the following:
(a) tfoot - (1) Order list
(b) start - (2) Hyperlink
(c) href - (3) Highlight
(d) mark - (4) Table
(@) (b) (c) (d)
A)4 1 2 3
B)1 4 3 2
C)4 32 1
D)1 2 4 3
7. Definition list has how many parts?
(A)5 (B) 4 (©C)3 (D)2
8. A list block can be defined inside another list is
(A) Inner List (B) Nested List (C) Outer List (D) Listing List
9. Read the following statement and choose the correct statement(s):
(1) Link in HTML is used to create hyperlinks to web content.
(1) HREF is abbreviated as Hypertext Markup File
(A) liscorrect (B) Il iscorrect (C) | and Il is correct (D) Both are wrong
10. To create internal link, which of the following attribute should be used?
(A) link (B) name (C) loca (D) Inter
PART-II
VERY SHORT ANSWERS:
1. Writeashort noteon (i) <strong> (ii) <em>
% <strong> Important text : The <strong> tag is a phrase tag. It is used to define
important text. This tag displays the text as bold.
% <em> - Emphasized text : The <em> tag is used to emphasize the text. That means,
when you use this tag, the text will be in italics.
2. What isthe use of <mark> tag?
% The <mark> tag is used to highlight the text in HTML. This is also a container
tag. Whatever the text given between <mark> and </mark> will be displayed as
highlighting with default color (mostly yellow).
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3. Writethe following equation asHTML notation: Pd = 2s — Q2

<Html>

<head>

<title>html notation</title>
</head>

<body>
Pd=2s-Q<sup>2</sup>
</body>

</html>

4. Write about any two attributes of font tag.

s Thefaceisan attribute to set different font style. The name of a font has multiple
words it should be specified within double quote.

% The size attribute is used to set size of the text. The size can have an absolute value
from 1 to 7. These predefined sizes are known as virtual size. Each virtual size is
successively 20% larger than the previous one.

s The color attribute is used to set the color to the text. As you leant earlier color name
or color code in hexadecimal may be used.

5. What isthematic break?

% The <hr> (Horizontal Rules) tag, which is known as “Thematic Breaks”
separate sections of an HTML document visually. It produces a horizontal line
spread across the width of the browser. This is an empty tag, which means the
tag has no closing tag.

6. What is pixel?

% A pixel isone of the tiny dots that make up the display on computer. Generally, 72
pixels equal to an inch. Pixel isusually referred as points.

% For example: The code <hr size = 72> display a horizontal line with 1 inchthickness.
The default size is 3 pixels.

7. What arethetypesof lissinHTML?

s HTML supports three types of lists viz. numbered, unnumbered and definition.
These lists are caled as Ordered List, Unordered List and Definition List
respectively.

8. How will you define numbered list?

s Numbered list is created within the tag pair <OL> ..... </OL> tag. The tag
<L 1> is used to present the list item in the list. Ordered list displays items in a
numerical or alphabetical order. Both <OL > and <L | > tags are container tags.

PART — Il
SHORT ANSWERS:

1. Writean HTML codeto display the following text in exactly the same way as
given below. | am studying Computer Science Application.

<html>

<head><title> Computer Application</title>

</head>

<body>

<h3> | am studying Computer Science Application</h3>
</body>

</html>
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Briefly explain the attributes of <hr> tag.

The <hr> tag having four attributes viz. size, width, noshade and color. These
attributes are used to set size, width, 3D appearance and color to the horizontal line
respectively.
The general syntax of <hr> tag with attributes: <hr size=value width=value
noshade, color=color _name/code>
What arethe coretags used to createtablein HTML?
There are five core tags are used to create atable in HTML. They are,
» <table> tag isused to create a table.
= <tr> tag defines table rows
= <th> tag defined table columns
= <td> tag is used to specify the datain a cell
= <caption> tag defines title for the table
Writean HTML codeto provide hyperlink to https://www.w3schools.com
<html>
<head><title> hyperlink</title>
</head>
<body>
<A href= “http://www.w3schools.com”> Click </A>
</body>
</html>
Difference between <UL > and <OL > tags.
Ordered lists: Numbered list is created within the tag pair <OL> ..... </OL> tag. The
tag <L 1> is used to present the list item in the list. Ordered list displaysitemsina
numerical or alphabetical order. Both <OL > and <L | > tags are container tags.
Unordered lists: Unordered lists are often referred as bulleted lists. Instead of
numbers, each element in the list has prefixed with a special bullet symbol. Unordered

list is surrounded within <UL> ......... </UL> tags. Each list element is defined by
<LI> tag.
6. Write HTML codeto producethe following Table:
A B
C
SOLUTION:

<table bor der=1 cellspacing=0 cellpadding=12>
<tr VAlign =top>
<td rowspan=2>A</td><td> B</td>

<[tr>

<tr><td> C</td>

<[tr>

</table>

PART-IV

EXPLAIN IN DETAIL:

1.

Writean HTML code the show the following text:
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MODERN ATOMIC THEORY

The findings of modern atomic theory are given as follows:
« Anatom is the smallest particle which takes part in chemical reaction.
 Anatom is considered to be a divisible particle.
o 'The atoms of the same element may not be similar in all respects.

eg: Isotopes (_CI¥, (1Y)
o 'The atoms of different elements may be similar in some respects,

eg. Isobars ( o\ ¥ mCu“’}

Program:
<html><head><title>table program</title></head>
<body>
<center>MODERN ATOMIC THEORY </center>
<b>The findings of modern atomic theory are given as follows:</b>
<ul >
<li>An atom is the smallest particle which takes part in chemical reaction.
<li>An atom is considered to be a divisible particle.
<li>The atoms of the same element may not be similar in all respects.
<dl>
<dd>eg: Isotopes (<sub>17</sub>Cl<sup>35</sup>,
<sub>17</sub>Cl<sup>37</sup>)
</dI> </ul>
<ul>
<li>The atoms of different elements may be similar in some respects.
<dl>
<dd>eg. Isobars (<sub>18</sub>Ar<sup>40</sup>,
<sub>20</sub>Ca<sup>40</sup>)
</dI>
</ul>
</body>
</html>
2. Explain the attributes used with <table>tagin HTML.
The <table> is a container tag. There are several attributes to improve the layout of the
table. They are listed below:
s Ceéllspacing: It isused to set the space between cells in atable. The value should be
in pixels.
% Cellpadding: It isused to set the space between the contents of a cell and its border.
the value should be in pixels
* Border: Border attribute with <table> tag is used to specify the thickness of the
border lines around the table.
¢ The value of the border attribute should be a non-zero value in pixels. (If its value
Is zero, HTML displays the table without border). The default value is Zero in
most the browsers.
% Bordercolor: It isused to apply the colour to the border lines.
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% Align: It is used to set the position of the table within the browser window. L eft isthe
default position. Right or center may be the value of align attribute.
s BGcolor: It isused to apply background colour to the table.
s Height and Width: These two attributes are used to specify the height and width of a
table in terms of pixels or percentage.
3. Explain thetypes of list with suitable HTML code.
s HTML supports three types of lists viz. numbered, unnumbered and definition.
% These lists are called as Ordered List, Unordered List and Definition List respectively.
Numbered List / Ordered List
= Numbered list iscreated within the tag pair <OL> ..... </OL> tag.
» Thetag <L 1> isused to present the list item in the list.
» Ordered list displaysitemsin a numerical or alphabetical order.
= Both <OL > and <L |> tags are container tags. closing tag </L 1> never be used.
Un-numbered List / Unordered List
» Unordered lists are often referred as bulleted lists. Instead of numbers, eachelement
in the list has prefixed with a special bullet symbol. Using<L|> tag
= Unordered list issurrounded within<UL> ......... </UL> tags
Definition List
% Definition list isdifferent from other two types of list. No bullet or number is provided
for the list items. Thelist element has two parts.
(1) A definition term
(2) The definition description
= Definition list is surrounded within <DL>....... </DL > tags.
= Definition term is presented in between <DT>.....</DT> tag and
= Definition description should be surrounded within <DD> ....... </DD> tag.
Example:
<html> <head> <title> list in Html</title</head>
<body>
<ol type=A>
<li> hardware
<li> software
<ul>
<ul type= B>
<li> network
<li> mail
</ul>
<dI>
<dt>HTML
<dd> Hypertext markup Lanaguage
</dI>
</body></html>
OUTPUT:
A
1. hardware
2. software
B
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» network
* mail
HTML
Hypertext markup Language

4. What isLink and explain thetypes of links.

% Link isan important feature of HTML to connect web resources.

% Link inHTML isused to create hyperlinks to web content.

s Web content may be an HTML document(inter nal) or an exter nal webpage or any
multimedia content such as an image, video, audio, animation etc., or even a part of
the current document.

% There are two important things needs to create alink in HTML,

(1) The name of the file or URL to which you want to link
(2) The text that will serve as the clickable link.

% The anchor tag <A> is used to create links along with HREF attribute. HREF is
abbreviated as “Hypertext Reference”.

¢+ Structure of an anchor tag with href:

<A href=“ Web content path / URL “> Text — Clickable link </A>
Example: <A href = "http://tnscert.org/index.ntml">SCERT </A>
5. WriteHTML codeto create the following table:

</table>

<table bor der=1 cellspacing=0 cellpadding=16>
<tr>

<td rowspan=3 VAlign=top>A</td>
<th colspan=4>B</th>

</tr>

<tr>

<td>C</td>

<td>D</td>

<td>E</td>

<td rowspan=2 VAlign=top>G</td>
</tr>

<tr> <th colspan=3>F</th></table>
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12. HTML - Adding multimedia elements and For ms
PART-I
CHOOSE THE BEST ANSWER:
1. Which image format was standardize by W3C?
(A)JPEG (B)SVG (C)GIF (D) PNG
2. Thetag used to insert animage in HTML.:
(A) Image (B) Picture (C) Img (D) Pic
3. InHTML, apiece of text or image can be moved horizontally or vertically by using:
(A) <marquee> (B) <img> (C) <embed> (D) <text>
4. Inline sound can be inserted using which of the following tag?
(A) <inline> (B) <backgr oundsound> (C) <bgsound> (D) <sound>
5. Which value causes the audio play as long as the page isin view?
(A) Stop  (B) Never Stop (C) Continue (D) Infinite
6. The important attributes used with the <form> tag are
(A) method and action (B) name and size
(C) postand get (D) type and name
7. Thetag is used to create dropdown list box in HTML is:

(A) <dropdown> (B) <select> (C) <list box> (D) <input>
8. Match the following:
(a) <textarea> - (1) inline
(b) <input> - (2) Video
(¢) <bgsound> - (3) Multiline input
(d) <embed> - (4) Password

(@) (b) (c) (d)
(A)3 1 4 2
B)3 4 1 2
23 41
(D)2 1 3 4

PART —II

SHORT ANSWER:
1. List out the popular image for mats.
Most of the browsers supports, GIF, JPEG and PNG images formats
% GIF (Graphical Interchange Format)
s JPEG (Joint Photographic Experts Group)
s PNG (Portable Network Graphics)
2. Writedown the general format of marquee
General format:
<marquee> Text or image to be scroll </marquee>
3. What isinline sound or movie?
% Music can be played in the background to a webpage, while the page is viewed. This
iIsknown as ‘inline’ sound or movie.
4. What isthe purpose of <input> tag?
% The purpose of <input> tag isto form controls, form controls are created by using
<input> tag. The <input> is an empty tag used to create different form elements or
controls such as text box, radio buttons so on.
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5. Which tag is used to specify thelist of itemsin dropdown list box?
% The <select> tag is used to create dropdown list box in HTML.
% It provides alist of various options as a dropdown list.
6. What arethemajor attributes are available in <textarea> tag?
% The <Textarea> tag used to receive multi line text data as input. It isa container
tag.
% The main attributes of <Textarea> are
» Name - Used to define name to the control
» Rows— Specifies the number of rows in the text area control
» Cols— Specifies the number of columns in the text area. (number of
charactersinaline)
PART —II1
SHORT ANSWERS:
1. Writeashort note on familiar images for mat.
I. GIF (Graphical | nterchange Format)
e Thisformat is one of the popular format for animated images.
e |t was developed by CompuServe.
This format is suitable for presenting tiny animated images, logos, icons, lineart etc.,
It is not suitable for photographic work, because it uses maximum of 256 colours.
Animated Gl F do not support sound or playback control.
ii. JPEG (Joint Photographic Experts Group)
e JPEG isthe most popular image format supported by all web browsers.
e Thisformat issuitable for photographic images.
e JPEG can include any number of colours.( supported Full color)
iii. PNG (Portable Networ k Graphics)
e PNG isdesigned as areplacement for GIF.
e |tisalso supported by all browsers.
iv. SVG (Scalable Vector Graphics) ----- SVG images.
e SVGisagraphics format that was developed for web.
e |t was standardized by World Wide Web Consortium (W3C) in 2001.
2. How will you scroll thetext inHTML?
s The HTML <marquee> tag is used for scrolling piece of text or image either
horizontally or vertically. This feature makes a web page as more attractive.
General format:
<marquee> Text or imageto be scroll </marquee>
s Attributes of <marquee> : Behavior, direction, Height & Width, loop, scrolldelay,
scrollamount, V space & Hspace, bgcolor .
3. Explain the main attributes used with <for m>tag.
Main Attributes used with <form> tag
% The important attributes used with the <form> tag are method and action
attributes.

M ethod
% The method attribute of the for m tag is used to identify how the form element names
and values will be sent to the server.

60




% The get method will append the names of the form elements and their values tothe

URL.

% The post method will send the names and values of the form elements as packets.

Action

s The action attribute identifies the server side program or script that will process the

form.

% The action will be the name of a Common Gateway Interface (CGI) program written
in programming languages like Perl, JavaScript, PHP or Active Server Pages (ASP).
4. Explain the values of <input> tag’s type attribute.

Walue
mttribaile

of tvpe

Descriptiom

Create a Text Box. The elemient used to get all kind of text input such

Lext as name. address eto,,
Pasaodd Similar as Text box. But, while entering data, the characters are
appearing as coded symbols such as asterisl.
Check box 15 an element appearing hke a small square box. When
Checkbox the user click on the square a tiny tick mark will appear inside the

square. Thiz element iz used to select multiple options.

Radio Rutton

Hl.‘"\-\.l,,"'!

Hadio button is used to select any one of the multiple options from

the list. This element looks ke a small circle, when the user select
IT the user zalacts

This

means, user can select any one of the given option form a group.

an iterm, a tiny dot will appear witthin the circle

another option, previously selected option will be deselected.

It iz o ~.[1|:=n'|.::| command button usaed 1o clear all the entries made in

the form.

St

made 11 the form to the

Buttoses

on click.

It is also a special command button used 1o submit

bBackerid

This iz a standard graphical button on the form used o call functions

all the entries

LaTear

5. Explain the attributes of <select> and <option> tags
s The <select> tag is used to create dropdown list box in HTML. It provides a list of
various options as a dropdown list. This element is more helpful when a number of
options are to be displayed in a limited space. The <option> tag is used to specify

list items.

Attributes of <Select> tag:

Attributes of <0ptxon* tag

Name - Provide the name to the

control, wh
\&:".'.;X’
Size - Determine the style
Size = 1 dropdown list box
Size = 2 List box

Multiple - Al l o

h 18

of dropdown 115t DoX

alant s titenla valiva
"‘I'T LI Ll | e rl._]i\lpl’: \ ‘,"4‘ ¥ L

Selected - Indicate default selection

Ule t .P.. S1] '".1'7{_,] N

Value -

Server
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13. CSS-CASCADING STYLE SHEETS

PART-1
CHOOSE THE BEST ANSWER:
1. Expansion of CSS
(A) Cascading Style Schools (B) Cascading Style Scheme
(C) Cascading Style Sheets (D) Cascading Style Shares
2. Which of the following isthe page level style?
(A) <Page> (B) <Style> (C) <Link> (D) <H>

3. CSSisalso called as:
(A) Sitewide Style Sheets (B) Internal Style Sheets

(C) Inline Style Sheets (D) Internal Inline Sheets

4. The extension of CSSfileis

(A) .ssc (B) .css (C) .csc (D) .htm

5. What is selector?

(A) Property (B) Vaue (C)HTML tag (D) name

6. The Declaration block of CSS is surrounded by

(A) () (B)I[1] ©) {} (D) <>

7. The declaration should be terminated by

(A): B); ©). (D),

8. What isthe property to set text as bold?

(A) Font-Style (B) Font-Weight (C) Font-Property (D) Font-Bold

9. Which of the following indicates that the text included isa comment ?

(A) [* */ (B) I* *I (C) <* *> (D) \* *\

10. Which of the following ways below is correct to write a CSS?

(A) pf color:red; text-align:center} ; (B) p {color:red; text-align:center}

(C) p{color:red; text-align:center;} (D) p (color:red;text-align:center;)
PART —II

VERY SHORT ANSWERS:

1. What isthe use of <style> tag?

» A styletag is used to change the default characteristics of a particular tag in theentire
web document wherever that tag is used.

» The <style> tag controls the presentation styles of a particular HTML document. If
you want to use a particular tag with the same style applied in one HTM L documentto
another is not possible.

» Thus, the <style> tags are called as “Page-Level Styles” or “Inter nal Stylesheets”.

2. What is CSS?

Cascading Style Sheets (CSS)

» CSSisastyle sheet language used for describing the formatting of a document written
iINHTML.

= You can control the font colour, font style, spacing between pages, columns size,
border colour, background image or colour and various other effects in a web page.

3. Writethe general format of linking CSSwith HTML.

General format of <Link> tag
<Link rel = “stylesheet” type = “text/css” href = CSS File Name with Extension>

ATTRIBUTE | VALUE DESCRIPTION

href URL Specifies the location of the linked document.
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rel stylesheet Specifies the relationship between the current document and
the related document.

type media_type Specifies the media type of the linked document

4. What isInline Style?
s Inline style is used to define style for a particular tag anywhere inan HTML doc.
» You can define styles for any tag within an HTML document.
% Butitisapplicable only onthat line whereit is defined
5. Writedown general format of CSS declaration.
CSS- Style definition rules
The body of the style sheet consists of a series of rules.

(AR

L)

(AR

Selector Declaration
HTML Tag { Properties : Values; }
PART — 111

SHORT ANSWERS
1. What arethe advantages of using CSS?
Advantages of CSS
% Maintainability -CSS are also defined and stored as separate files. So, the style and
appearance of aweb page can be dynamically changed and maintain with lesseffort.
% Reusability - The styles defined in CSS can be reused in multiple HTML pages.
% Easy to understand - The tagsin web pages are well organized with style
specifications and therefore it is easy to understand
2. Writeashort noteon rule of CSS.
CSS style declaration consists of two major parts; Selector and Declaration.
The Selector refers an HTML tag in which you want to apply styles.
The Declaration isablock of code contains style definition.
It should be surrounded by curly braces.
Y ou can include any number of properties for each selector, and they must be separated
by semicolons(;).
The property name and its value should be separated by a colon.
Each declaration should be terminated by a semicolon ( ;).
3. Writea CSSfileto definetext color and alignment to <p>tag.
Mystyle.css - CSSfile
P

{
}

NOTE: Save the cssfile with extension .css
4. Writea CSSfileto define font type, style and size to <h1>tag.
Mystyle.css - CSSfile
H1
{

Font-family : “Times New Roman”; Font-style : Italic; Font-size : 14px;

}

NOTE: Save the css file with extension .css

e

*

e

*
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color:pink; Text-align : center;
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PART - IV

EXPLAIN IN DETAIL:

1. Writean HTML document to display the following paragraph as per the given
description Using CSS:
» Font Name: Cooper Black
» Style: Bold Italics
» Color : Blue
“The State Institute of Education (SIE) was established in 1965 to provide for
systematic study of problemsrelating to School Education under the administration of
Directorate of School Education.”
<html>
<head><title> CSS DOCUMENT</title>
<style>
P

{
Font-family: “Cooper Black”; Font-weight: Bold ; Font-style: Italics; Color: Blue;

}

</style>

<body>

<p>

The State I nstitute of Education (SIE) was established in 1965 to provide for systematic
study of problems relating to School Education under the administration of Directorate of
School Education.

</p>
</body>
</html>
2. List and explain the Font and text element properties and values used CSS
Formatting Properties Values Example
Text Colour Color Predefined Color | P
_Name {
color:pink;
}
H1
{
color :
MediumSeaGreen
}
Text Alignment Text-align Center / Left/ P
Right / Justify {
Text-align :
center; }
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Font type

Font-family

Font_name

P
{

Font-family :
“Times New
Roman”;

}

Font Style

Font-style

Normal / Italic

P
{

Font-family :
“Times New
Roman”;
Font-style : Italic;
}

Font Style (Bold)

Font-weight

Normal / Bold

P
{

Font-family :
“Times New
Roman”;
Font-style : Italic;
Font-weight :
bold;

}

Font size

Font-size

Sizein pixels

P
{
Font-family :
“Times New
Roman”;
Font-style : Italic;
Font-size : 14px;

}

Background
Colour

Background
Colour

Predefined Color
_Name

Body
{

background-color
: violet;

}

Border Colour

Border

Border thickness
<space> border
style <space>
Predefined border
Color_Name

H2 { border : 2px
solid red; }

Background
Image

Background-
image

URL (“image
name with
extension”)

Body
{
background-image
- url

(“Flower.gif ”);

}
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Background-
repeat

norepeat

Body
{

background-image
- url

(“Flower.gif ”);
background-repeat

horepeat;
}

Background-
position

Direction

Body
{
background-image
- url

(“Flower.gif ”);
background-repeat

norepeat;
background-
position : right
top;

}

Paragraph
Margin

Margin-top

Margin-
bottom

Margin-left
Margin-right

Marginsizein
pixels

P

{
Margin-top : 50px;
Margin-left : 50px;

}
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14. INTRODUCTION TO JAVASCRIPT
PART-I
CHOOSE THE FOLLOWING:
1. Which provided a common scripting language to web developers to design, test and
deploy Internet Application?
A)C B) C++ C) Java D) JavaScript
2. Expand CGlI
A) Common Gateway Interface B) Complex Gateway Information
C) Common Gateway I nformation D) Complex Gateway Interface
3. JavaScript programming language is used to develop the
A) Dynamic Web Page B) Window C) Web Page D) Home Page
4. The Dynamic Web Page help to save server’s
A) Work B) Route C) Traffic D) Path
5. User entered data, is validated before sending it to server is called
A) Server traffic B) Dynamic Web Page
C) Server Route D) Web server
6. Java Scripts can be implemented using which statements?
A) <head> B) <Java> C) <script> D) <text>
7. Expand DHTML
A) Distance Hyper Text Markup language B) Dynamic Hyper Text M arkup language
C) Distance High Text Markup language D) Dynamic High Text Markup language
8. How many attributes specifies that <script> tag in the scripting

A)2 B) 3 C4 D)5
9. Which attribute is used to indicate the scripting language and its value should be sent to
Text/JavaScript”

A) Language B) Textt C)Type D) Body
10. Thefilereload into the browser use the shortcut key is

A) R2 B) F3 C)F4 D) F5

11. JavaScript ignores spaces that appear between

A) Command B) Scripts C) Tokens D) Text

12. A Data value for variable that appears directly in a program by using a
A) loop B) Literal C) Statement D) Text

13. Which is mostly used to give awarning message to users?
A) Alert Dialog Box B) Confirmbox  C) Prompt box D) Display box
14. In the below snippet, value of x isvar x = 250 + 2 — 200;
A) 50 B) 52 C) 48 D) 42
PART-II
VERY SHORT ANSWERS:
1. Writea syntax of <script> tag
% The syntax of JavaScript segment in Hyper Text Markup Language (HTML) or
Dynamic Hyper Text Markup Language (DHTML) isas follows:
<script language="javascript" type="text/javascript" >
JavaScript code
</script>
2. What is scope of variables and types of scope variable?
The scope of avariable is the life time of a variable of source code in which it is defined.
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% Global: A global variable has global scope; it can be defined everywhere inthe

JavaScript code.
s Local: Variables declared within a function are defined only within the body of the

function. They are local variables and have local scope.
3. Writeanotesto type casting in JavaScript
s Type conversion isthe act of converting one data type into a different data type which

Isalso called as casting. In JavaScript there are two type of casting,
% Implicit casting and Explicit casting
% Implicit casting occurs automatically in JavaScript when youchange the data stored

inavariable
4. How many Literalsin JavaScript and mention itstypes.

Literals

A literal isafixed value given to avariable in source code.
% Literals are often used to initialize variables.
s Values may be Integer, Floating point, Character, String and Boolean. For Example,
write statement: Display Statement

General Syntax: Document.write ("string " + var);
5. What is conditional operator give suitable example.
% The?: isthe conditional operator in JavaScript, which requires three operands, hence it
is called the ternary operator.
The syntax isvar variablename=(condition) ? valuel : value2;
For example, var result=(10>15) 7100 :150;
What are the commentsin Java Script?
% There are two types of comments, Single line and M ultiple lines comments.
% Single-line comments begin with a double slash (//), causing the interpreter to

ignore everything from that point to the end of the line.
% Multiple line comments begins with /* and ends with */.
7. Write note on types of Operator.
The typeof operator is used to get the data type (returns a string) of its operand.
The operand can be either aliteral or a data structure such as a variable, a function,
an object.

% The operator returns the data type.

7
*

*

O & o
C DX

0’0

0’0

Syntax:

typeof operand or typeof(operand)
typeof returns: boolean, function, number, string, and undefined
8. Writetherulesof variablein JavaScript.
s Thefirst character must be aletter or an underscore (_). Number cannot be as thefirst
character.
% Therest of the variable name can include any letter, any number, or the underscore.
% JavaScript variable names are case sensitive. That is, a variable named RegNum is
different variable than named regnum.
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X4

There is no limit to the length of the variable name.

JavaScript's reserved words cannot be used as a variable name.

What isthe uses of prompt dialog box?

The prompt dialog box is very useful when the user want to pop-up atext box to get
user input. It enables you to interact with the user.

% The user needs to fill in the text box field and then click OK.

PART-III

L)

O
£

*

SHORT ANSWERS:

1. What are the advantages of programming language?

% To develop interactive pages (Dynamic Web page), JavaScript programming
language is used.

s User entered data in the Dynamic Web page can be validated before sending it to the
server.

% This saves server traffic, which means less load on your server.

¢+ JavaScript includes such items as Textboxes, Buttons, drag-and-drop,components
and sliders to give a Rich Interface to site visitors.

2. Brief thebasic data typesin Java Scripts.

The basic data types in JavaScript are Strings, Numbers, and Booleans.
String:

e Stringisalist of characters.

e A string literal isindicated by enclosing the characters in single(single character) or
double quotes (multiple characters). Including whitespace and special characters
such as\n (the newline).

Numbers:

e Number can beinteger or floating-point numerical value and numeric literalsare

specified in the natural way.
Boolean:

e Boolean can be any one of two values: true or false.

e Boolean literals are indicated by using true or false directly in the source code.

3. Write note on string Operator.

¢+ One of the built-in features of JavaScript is the ability to concatenate strings.

% The + operator performs addition on numbers but also serves as theconcatenation
operator for strings.

¢ + operator which is also called as the string concatenation operator.
4. Write about <script> tag

JavaScript can be implemented using <script>... </script> tags.

The <script> tag containing JavaScript can be placed anywhere within in the web

page, but it is normally recommended that should be kept it within the <head> tags.

s The <script> tag alerts the browser program to start interpreting all the text between
these tags as a script commands
The syntax of JavaScript segment in Hyper Text Markup Language (HTML) or

Dynamic Hyper Text Markup Language (DHTML) is as follows:
<script language="javascript" type="text/javascript" >
JavaScript code
</script>

) )
0.0 0.0
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The <SCRIPT> tag takes two important attributes —

% Language — This attribute specifies that the scripting language. Typically, its value
will be javascript. Although recent versions of HTML (EXtensible HyperText
Markup Language -XHTML, its successor) have phased out the use of this
attribute isoptional.

s Type— Thisattribute is used to indicate the scripting language and its value should be
set to "text/javascript".

5. What arethe uses of Logical Operators?

% Logical operators combine or invert boolean values.

% Once comparisons are made, the logical operators && (AND), || (OR) and ! (NOT)
can be used to create more complex conditions. Use logical operators on boolean
operands for good practice.

6. Difference between the increment and Decrement oper ator .

| ncrement oper ator Decrement oper ator

The ++ operator increments its single The -- operator decrements its single operand
operand.

Its converts its operand to anumber, adds 1 | Its converts its operand to a number,
to that number, and assigns the incremented | subtracts 1 to that number, and assigns the

value back into the variable decremented value back into the operand
Post increment: var m=3, n=m++; Post decrement: var m=3, n=m--;
Pre increment: var m=3, n=++; Pre decrement: var m=3, n=m--;

PART -1V

EXPLAIN IN DETAIL:
1. Explain about the popup dialog boxes in JavaScript.

JavaScript supports three kind of popup boxes: 1. Alert box 2. Confirm box 3.Prompt
box. These dialog boxes can be used to raise an alert, or to get confirmation on any input or
to have a kind of input from the users.

1. Alert Dialog Box:
% Analert dialog box is mostly used to give a warning message to the users.
« For example, Some fields are incomplete in form, then as a part of validation, youcan
use an alert box to give awarning message.
Alert box gives only one button " OK" to select and proceed.
The syntax of alert box is
Alert(“Message”); (or) Window.alert(“Message™);
Example: alert(“Name iscompulsory entry”); (or) window.alert(“Name iScompulsory
entry”);
2. Confirm Dialog Box:
s A confirmation dialog box is mostly used to take user's consent on any option.
» It displays a dialog box with two buttons: OK and Cancel.
If the user clicks on the OK button, the confirm() will return true.
If the user clicks on the Cancel button, then confirm() returns false.
The syntax of confirm dialog box is
confirm(“message’); (or) window.confirm(“message”);
Example: confirm(“Do you want to continue:”); (or) window.confirm(“Do youwant
to continue:”);
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3. Prompt Dialog Box:

s The prompt dialog box is very useful when the user want to pop-up atext box to get
user input. Thus, it enables you to interact with the user.
The user needs to fill in the text box field and then click OK.
The prompt dialog box is displayed using a method called prompt() which takestwo
parameters:
(i) label which you want to display in the text box and a (ii)default string to display
inthe text box.
This dialog box has two buttons: OK and Cancel.
If the user clicks the OK button, it will return the entered value from the text box.
If the user clicks the Cancel button, it returns null.
The Syntax of prompt dialog box is, Prompt(“Message”,”defaultValue”); (or)
window.prompt(" sometext" ," defaultText");
Example: prompt(“Enter Your Name:”,”Name”); (or) window.prompt(“Enter Your
Name:”,”Name”);

2. Explain about the Arithmetic operator with suitable example.

JavaScript supports al the basic arithmetic operators like addition (+), subtraction (-),

multiplication (*), division (/), and modulus (%, also known as the remainder operator).

o
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Arithmetic M eaning Example Result

Oper ator

+ Addition var sum=20+ 120 | Variablesum= 140

- Subtraction var diff =20 — 120 Variable diff = 100

* Multiplication var prod=10* 100 | Variable prod = 1000

/ Division var res = 100/522 Variableres=5.22

% M odulus operator var rem =100 % 522 | Variable rem = 22
(remainder)

Example:

<Html>

<Head>

<Title>Demo Program — To test Arithmetic Operators in JavaScript </Title>
</Head>
<Body>
<script language="javascript" type="text/javascript">
var valuel = 522, value2=10;
document.write("<br>Datal : "+valuel);
document.write("<br>Data2 : "+value?);
document.write("<br><br>The Sum of Datal and Data2 : " var sum = valuel+value?);
document.write("<br>The Difference of Datal and Data2 : " var diff = valuel-value2);
document.write("<br>The Product of Datal and Data2 : " var prod = valuel*value2);
document.write("<br>The Result after Division of Datal and Data? : "var res =
valuel/value?);
document.write("<br>The Remainder after Division of Datal and Data2 : "var rem =
valuel%value?);
</script>
</Body>
</Html>
71




15. CONTROL STRUCTURE IN JAVASCRIPT
PART-

CHOOSE THE BEST ANSWER:

1. Which conditional statement is used to transfer control from current statement to another
statement?

(a) Branching (b) Sequencing  (c) Looping (d) Interating

2. statement can be used as alterative to if-else statement. (LOT)

(@ While  (b) If (c) Else-if  (d) Switch

3. Which statement in switch case is used to exit the statement once the appropriate choice is
found?

(a) Exit (b) Default (c) Case  (d) Break

4. Which of the following is not a looping statement? (LOT)

(@) Switch (b) While (c) Do-While (d) For

5. Which part of the loop statement determines the number of times, the loop will be
iterated? (MQOT)

(@) First (b) Second (c) Third  (d) Final

6. Which of the following is not a branching statement? (LOT)

(@ Loop (b) If-else (c) Switch (d) For

7. What will be the output for the following snippet: (HOT)

For (var n=0; n<10; n+1)

{

if (Nn==3)

{

break;

}

document write (n+"<br>");
}
@012 (0123 (c)01234 (do0,1,3
8. In which loop the condition is evaluated, before executing a statement? (MOT)
(@) While (b) Do while (c) Break  (d) Continue
9. The statement is especially useful when testing all the possible results of an
expression. (LOT)
(& While  (b) Do while (c) Switch  (d) If
10. In the loop, body of the loop always executed at |east once before the condition
can be executed. (LOT)
(@) For (b) While (c) If (d) Do while
11. <script type = "text / javascript">
X=6+"3"
document write (X);
<script> what will be the output?
@6 (b9 (c) 63 (d) Error
PART - 11

VERY SHORT ANSWERS:

1. What arethedifferent types of control statement used in JavaScript?

There are two types of controls,
» Branching / Selection
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» Looping/ repetitive
2. What is meant by conditional statementsin JavaScript?
» Statements are executed in the order they are found in a script.
» Conditional statements execute or skip one or set of statements depending on thevalue
of a specified conditional expression.
3. List out the various branching statementsin JavaScript?
There are different branching statements. They are,
If statement (Single way branch) if ... else statement (Two way branch)
0 switch statement (Multi way branch), elseif statement (Two way branch),
4. Writethe general syntax for switch statement
switch(expression)
{
case label1: statementsl; break;
case label2: statements2; break;
case labeln; statements - N; break;
default: (optional)

o

statements;
}
5. Differentiate the break and continue statement.
break statement continue statement
The break statement will terminate theloop | The continue statement will skip back to the
early loop condition check.

PART - 111
SHORT ANSWERS:
1. What isif statement and writeits types.
v Theif statement isthe fundamental control statement that allows JavaScript to make
decisions to execute statements conditionally.
v" This statement has two forms. The form isfor only true condition.
v Types of if statement if
(condition) if else statement
{ elseif statement
True block; nested if statement
}
2. Writethe syntax for else-if statement.
iIf (Condition 1)
{ block 1; }
elseif (condition 2)
{ block 2; }
elseif (condition 3)
{ block 3; }
else
{ block 4; }
3. What iscalled aloop and what areits types?
v" In JavaScript there are times when the same portion of code needs to be executed
many times with slightly different values is called Loops. .
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v' JavaScript supports three kinds of looping statements. They are for

loop ,whileloop and do..while loop

4. Differentiate between while and do while statements

while statements

do while statements

first condition will be evaluated and then
only based on the result of the condition the
body of the loop will be executed or not.

do..while loop body of the loop always
executed at least once before the condition
can be executed.

Entry check loop

Exit check loop

Checking and execution time of loop is differ
in while loop

Checking and execution time of loop is
same in do while loop

5. What message will be displayed, if theinput for ageisgiven as 20, for the

following snippet.

if (age>=18)

{

alert ("you are€ligibleto get Driving licence" }
}

else

alert ("you are not eligible to get driving licence");

Message will be display like you are eligible to get Driving licence
PART -1V

EXPLAIN IN DETAIL:
1. Explainfor loop with example

» Thefor loop isavery rigid structure that loops for a pre-set number of times.
> InJavaScript for structure isvery flexible, which makes this type is very useful.

The syntax:

for (initialization; condition; increment/decr ement)

{
Body of the loop;

}

The for structure within parenthesis there are thr ee parts each separated by semicolon;.

They are,

» Thefirst part of the loop initializes a variable which isalso called as contr ol variable.
» The second part isthe conditional statement that determines how many times the loop

will be iterated (executed).

» Thethird and final part determines how the value of control variable is

changed(l ncremented/Decremented)
Example:
for (var x=0;x<3;x++)

{

document.write(x+ “<br>");

}

2. Explain switch case statement with example
% JavaScripts offers the switch statement as an alternate to using if...else structure.
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s The switch statement is especially useful when testing all the possible results of an
expression.
The syntax of a switch structure as the following:
switch(expression)
{
case label1: statementsl; break;
case label2: statements2; break;
case labeln; statements - N; break;
default: (optional)
statements;
}
The default structure is can be at the end of a switch structure if the result of the expression
that do not match any of the case labels.
Example:
var ch=2;
switch(ch)
{
case 1. document.write("Y our Grade is Outstanding.."); break;
case 2. document.write("Y our Grade is Excellent.."); break;
case 3. document.write("Y our Grade is Good.."); break;
case 4: document.write("Y our Grade is Satisfectory.."); break;
default: document.write("Y our Grade Poor and have to re-appear Exam..");

}

3. Writethe output for the following program
<Html>
<Head>
<Title> for statement</title>
<Head>
<Body>
<script language= "java Script" type = "text / javaScript")
var nol= prompt ("please enter table you want:", "0" );
document write ("<h2> multiplication for your need </h2>")
for (Var no2= 0; no2<=10; no2++)

{

document write (nol+ "x" + no2+ "=" + nol*no2+ "<br>);
}
</script>
</body>
</Html>
SOLUTION:
Output:
Multiplication for your need
5x0=0
ox1=5
5x2=10
5x3=15
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5x4=20
S5X5=25
5x6=30
SX7=35
5x8=40
5x9=45
5x10=50

Explorer User Prompt lﬂ

- =
please enter table you want:
Cancel

|5

4. Write a Java Script program using while statement to display 10 numbers.
<Html>

<Head> <Title>Program - To test while statement in JavaScript </Title> </Head>
<Body>

<script language="javascript" type="text/javascript">

document.write("<h2> Using while Statement </h2>");

var no2=0;

while(no2<10)

{

document.write(no2+" ");

no2=no2+1;

}

</script>

</Body>

</Html>

OUTPUT:

0123456789
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16. JAVASCRIPT FUNCTIONS
PART-I
CHOOSE THE CORRECT ANSWER:
1. The parameters work as
A) Local variable B) Global Variable
C) File variable D) block variable
2. Predefined functions are also called as
A)Library functions  B) storage functions

C) instructions D) commands

3. Larger programs are divided into smaller are called

A) modules B) block

C) sets D) Group

4. Which of the following is used to enhance reusability and program clarity.
A) functions B) modules

C) sets D) instructions

5. Which of the following allow the programmer to modularize a program
A) Library functions B) user defined functions
C) Normal functions D) Ordinary functions
PART-II
VERY SHORT ANSWERS:
1. What isafunction in JavaScript?

% A function is a block of JavaScript code that is defined once but may be
executed or invoked any number of times. Functions are used to encapsulate
code that performs a specific task.

2. What isthe use of function?

% Function is used to keep code that performs a particular job in one place in

order to enhance reusability and program clarity.
3. Writeanoteon Library functions.

% Pre-defined functions are already defined in the JavaScript library which are
also called Library functions. For example toUpperCase(), toLowerCase() etc.,
are pre-defined functions.

4. Writeanote on user defined functions.
s User-defined functions allow the programmer to modularize a program.
+ This eliminates the need of writing the same code again and again.
5. Write the syntax of functions.
Function function-name(parameterslist)

{
Function Body ;
}
Note: Function body include Declaration of variable and Executable statements.
PART III
SHORT ANSWERS:

1. Writeaprogram in JavaScript to find the cube of a number using function
<html>
<body>
<script language="javascript" type="text/javascript">
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var n=prompt("enter value:","0");
var c=cube(n);
document.writeln("the value is "+n+" the cube of given value is"+c);
function cube(x)
{
var C=xX*xX*X;
return c;
}
</script>
</body>
</html>
2. Writeaprogram in JavaScript to find the sum of 10 numbers usingfunction.
<html>
<head>
<title>Javascript</title>
<script language="javascript" type="“text/javascript’>
var n=9,sum=0,tot=add(n);
function add(j)
{
for (vari=0;i<=j; i++)
{ sum+=i;}
return sum;
} document.write("result"+sum);
</script>
</head>
<body>
</body>
</html>
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17. COMPUTER ETHICSAND CYBER SECURITY
PART-I
Choose the best Answer .
1. Which of the following is a set moral principles that regulates the use of computers

a. piracy b. programs C. Virus d. computer ethics
2. Commercial programs made available to the public illegally are known as
a. freeware b.warez c.freesoftware d. software

3. Which one of the following are self-repeating and do not require a computer programto
attach themselves?

a. viruses b.worms c. spyware d. Trojans

4. Which one of the following tracks a user visits a website?

a. spyware b.cookies c.worms d. Trojans

5. Which of the following is not a malicious program on computer systems?

a.worms b. Trojans c. spyware d. cookies

6. A computer network security that monitors and controls incoming and outgoing traffic is
a. Cookies b.Virus c. Firewall d. worms

7. The process of converting cipher text to plain text is called

a. Encryption b. Decryption  c. key d. proxy server

8. e-commerce means

a. electronic commerce b. electronic data exchange

c. electric data exchange d. electronic commercialization.

9. Distributing unwanted e-mail to others is called.

a. scam b. spam c. fraud d. spoofing

10. Legal recognition for transactions are carried out by

a. Electronic Data I nter change b. Electronic Data Exchange
c. Electronic Data Transfer d. Electrical Data Interchange
PART-II

VERY SHORT ANSWERS:
1. What is harvesting?
% A person or programcollects login and password information from a legitimate user to
illegally gain access to others’ accounts iscalled harvesting.
2. What are Warez?
« Commercial programs that are made available to the public illegally are oftencalled
warez.
3. Write a short note on cracking.
% “Cracking” meanstrying to get into computer systemsin order to steal, corrupt, or
illegitimately view data.
+ Cracking iswhere someone edits a program source so that the code can be exploited or
modified.
4. Writetwo types of cyber-attacks.
% Pharming
¢ Phishing
5. What isa Cookie?
% A cookie isasmall piece of data sent from a website and stored on the user'scomputer
memory
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PART-III
SHORT ANSWERS:
1. What istherole of firewalls?
e To monitors and controls incoming and outgoing network traffic based onpredefined
security rules.
e To establishes a block between atrusted internal computer network and entrusted
computer outside the network.
2. Write about encryption and decryption.
e Encryption: Encryption isthe process of translating the plain text data (plaintext) into
random and mangled data (called cipher-text).
e Decryption: Decryption isthe reverse process of converting the cipher-text back to
plaintext.
3. What arethe guidelines to be followed by any computer user?
e Complex password setting can make your surfing secured.
e When the internet is not in use, disconnect it.
e Do NOT open spam mail or emails that have an unfamiliar sender.
e When using anti-virus software, keep it up-to-date.
4. What are ethical issues? Name some.

An Ethical issue isa problem or issue that requires a person or organization to choose
between alternatives that must be evaluated as right or wrong. Some of the common ethical
issues are listed below:

e Cyber crime
Software Piracy
Unauthorized Access
Hacking
Use of computers to commit fraud

PART-1V
EXPLAIN IN DETAIL:
1. What ar e the various crimes happening using computer ?

Crime Function

Cyber Terrorism Hacking, threats, and blackmailing towards
a business or a person.

Cyber stalking Harassing through online.

Maware Malware or malicious software is any

program or file that is harmful to a
computer user.

Denial of service attack Overloading a system with fake requests

Fraud Computer fraud is the act of using a
computer to take or alter electronic data
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Harvesting A person or program collects login and
password information from a legitimate
user to illegally gain access to others’
account(s).

|dentity theft It isacrime where the criminals
impersonate individuals, usually for
financial gain.

Intellectual property theft Stealing practical or conceptual information
developed by another person or company.

Salami slicing Stealing tiny amounts of money from each
transaction.

Scam Tricking people into believing something
that is not true.

Spam Distribute unwanted e-mail to alarge
number of internet users.

Spoofing It isamalicious practice in which
communication is send from unknown
source disguised as a source known to the
receiver.

2. What is piracy? M ention the types of piracy? How can it be prevented?

% Software Piracy is about the copyright violation of software created originally by an
individual or an institution.

% It includes stealing of codes/ programs and other information illegally and creating
duplicate copies by unauthorized means and utilizing this data either for one’s own
benefit or for commercial profit.

% Software Piracy is “unauthorized copying of software”.

s Anentirely different approach to software piracy is called Shareware; this
acknowledges the futility of trying to stop people from copying software and instead
relies on people’s honesty.

« Commercial programs that are made available to the public illegally are oftencalled
Warez.
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3. Write thedifferent types of cyber-attacks.

Function

A virus is a small piece of computer code that can repeat itselt
and spreads from one computer to another by attaching itself
to another computer file. One of the most common virus is
Trojan.

A Trojan virus is a program that appears to perform one
function (for example, virus removal) but actually performs
malicious activity when executed.

Worms are self- repeating and do not require a computer
program to attach themselves. Worms continually look for
vulnerabilities and report back to the author of the worm when
weaknesses are discovered.

Spyware can be installed on the computer automatically
when the attachments are open, by clicking on links or by
downloading infected software.

S.No. Cyber Attack
1. Virus

2. Worms

3. Spyware

4. Ransomware

Ransomware is a type of malicious program that demands
payment after launching a cyber-attack on a computer system,
This type of malware has become increasingly popular among
criminals and costs the organizations millions each year.
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18. TAMIL COMPUTING
VERY SHORT ANSWERS:
1. List the search engines supported by Tamil language.

+ In the top ten search engines, Google, Bing and Y ahoo take first threeplaces
respectively.

2. What arethe keyboard layouts used in Android?

s Sellinam and Ponmadal — are familiar Tamil keyboard layouts that work onAndroid
operating system in Smart phone using phonetics.

3. Write a short note about Tamil Programming L anguage.

¢ Programming languages to develop software in computers and smart phonesare
available only in English.

s Now, efforts are taken to develop programming languages in Tamil. Based on Python
programming language, the first Tamil programming language “Ezhil” (enflev)is
designed. With the help of this programming language, you can write simple programs
in Tamil.

4. What isTSCII?

s TSCII (Tamil Script Code for Information Interchange) is the first coding system to
handle our Tamil language in an analysis of an encoding scheme that is easily handled
in electronic devices, including non-English computers.

% This encoding scheme was registered in IANA (Internet Assigned NumbersAuthority)
aunit of ICANN.

5. Writeashort note on Tamil Virtual Academy.
% With the objectives of spreading Tamil to the entire world through internet, Tamil

Virtual University was established on 17th February 2001 by the Govt. of Tamilnadu.
% This organization is functioning with the name of “Tamil Virtual Academy”.
+ This organization offers different courses regarding Tamil language, Culture, heritage
etc., from kindergarten to under graduation level.




